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APRESENTAÇÃO
É com muita satisfação que apresentamos o terceiro volume da série de manuais sobre os diversos 

aspectos que envolvem a metodologia do Programa Produtor de Água, que se destina a promover a 

conservação de recursos hídricos no meio rural, favorecendo a segurança hídrica.

O Programa foi concebido há pouco mais de vinte anos e apoiou técnica e financeiramente a 

estruturação de projetos de conservação de água e solo em várias regiões do Brasil. Os projetos apoiados 

possuem arranjos institucionais específicos de modo a considerar as particularidades locais e regionais, 

sempre buscando contribuir com a melhoria da disponibilidade hídrica, em termos de quantidade e 

qualidade, por meio de ações voltadas para a revitalização de bacias hidrográficas.

As experiências adquiridas com o apoio aos projetos proporcionaram as condições necessárias 

para a elaboração desta série de manuais. Com conteúdos voltados para elaboração de novos projetos, 

implantação de práticas vegetativas, mecânicas e edáficas, bem como para a realização de diagnóstico 

e elaboração de projetos individuais de propriedades rurais, estes manuais mantêm-se fiéis às linhas e 

diretrizes do Produtor de Água. 

Seguindo o que está contido nestes manuais, os interessados terão as bases para a estruturação e 

implementação de projetos e práticas convergentes com o Programa Produtor de Água e poderão usufruir, 

tanto dos modelos aqui apresentados, quanto dos demais manuais que compõem a série Manuais do 

Programa Produtor de Água.

Na oportunidade agradecemos a contribuição de todos que se envolveram com este Programa 

e reconhecemos que este trabalho somente foi possível por contar com os parceiros que, localmente, 

conduzem os projetos e trazem as grandes contribuições para a melhoria da qualidade e para o aumento 

da oferta de água nos mananciais trabalhados.

Boa leitura!

Diretoria Colegiada da ANA
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1	 INTRODUÇÃO
Criada pela Lei nº 9.984/2000, a Agência Nacional de Águas e Saneamento Básico (ANA) é a agência 

reguladora responsável por implementar a Política Nacional de Recursos Hídricos (Lei nº 9.433/1997), e 

por instituir normas de referência para os serviços de saneamento básico (Lei nº 14.026/2020). De acordo 

com o seu Planejamento Estratégico 2023-2026, a missão da ANA é garantir a segurança hídrica para o 

desenvolvimento sustentável do Brasil e contribuir para a universalização do saneamento básico.

Para a consecução dos seus objetivos, a Política Nacional de Recursos Hídricos (PNRH) tem como 

diretriz a integração da gestão de recursos hídricos com a gestão ambiental e a articulação com as políticas 

do uso do solo. Entre outras atribuições, cabe à ANA propor, elaborar, implementar e coordenar projetos e 

ações de estímulo à conservação de água e solo, inclusive com incentivos financeiros. Com base nisto, em 

2001, a instituição decidiu avaliar a possibilidade de implementar um programa voltado à disseminação de 

modelos eficientes de conservação de recursos hídricos nas bacias hidrográficas brasileiras.

1.1	 O Programa Produtor de Água

Estudos conduzidos pela equipe ANA, quando de sua criação, constataram que um dos grandes 

problemas que afetavam a qualidade da água nas bacias hidrográficas brasileiras estava associado a processos 

de degradação do solo e, que os programas agroambientais mais eficientes eram os que consideravam: a 

gestão baseada em parcerias; os efeitos ambientais que extrapolam os limites das propriedades; e a adoção de 

incentivos financeiros proporcionais aos benefícios ambientais gerados ao longo do tempo, fundamentados 

no princípio do “provedor-recebedor”. Nascia, assim, o Programa Produtor de Água, que busca contribuir 

com a segurança hídrica por meio do estabelecimento de parcerias para o desenvolvimento de projetos 

locais que promovam a adoção de práticas de conservação de água e solo no meio rural, associados, 

preferencialmente, ao Pagamento por Serviços Ambientais (PSA). 

As matas ciliares e os remanescentes de vegetação nativa são de grande importância para a proteção 

dos recursos hídricos. No entanto, em boa parte das bacias hidrográficas brasileiras, predomina o uso e 

ocupação por atividades produtivas, o que exige que qualquer planejamento que vise a revitalização e 

conservação do território considerem simultaneamente a relevância dessas áreas para a produção de 

alimentos, energia e para a conservação de água e solo.

Assim, a revitalização de bacias hidrográficas, realizada no âmbito do Programa, tem como princípio a 

busca pelo equilíbrio entre produção agrícola e a conservação ambiental. No Programa Produtor de Água, 

o planejamento das intervenções nas propriedades considera o sistema atual de produção, respeitando as 

particularidades e necessidades de cada produtor rural. É no meio rural, portanto, que as ações do Programa 

são conduzidas. Essa perspectiva nos leva às seguintes definições:

Definição do Programa Produtor de Água

O Programa Produtor de Água é uma ação da ANA destinada a promover a 

conservação de recursos hídricos no meio rural, visando segurança hídrica.

Definição de um Projeto Produtor de Água

Um Projeto Produtor de Água pode ser definido como o conjunto de ações 

planejadas e coordenadas por arranjo institucional local, visando a revitalização 

de bacias hidrográficas, sob diretrizes estabelecidas pelo Programa Produtor de 

Água.
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Embora os projetos que integram o Programa sigam diretrizes gerais estabelecidas pela ANA, cada 

iniciativa possui ampla autonomia para definir seu próprio regulamento. Isso significa que podem apresentar 

grande diversidade em suas ações de campo, bem como nas metodologias utilizadas para a valoração 

dos serviços ambientais. Essa autonomia na definição das formas de atuação constitui um dos pilares do 

Programa, permitindo que gestores locais se sintam plenamente responsáveis pela condução dos projetos 

e pela apropriação de seus resultados. O Programa preconiza, ainda, que os novos projetos incorporem 

as experiências dos mais antigos, com a possibilidade de aprimoramento contínuo. Isso tem resultado em 

projetos cada vez mais modernos, justos, eficientes e com menores custos de transação.

Conforme Resolução ANA nº 180, de 18 de janeiro de 2024, que aprovou as novas Diretrizes do 

Programa, para que um projeto possa ser reconhecido como integrante do Programa Produtor de Água, é 

necessário cumprir os requisitos abaixo apresentados. 

Requisitos a serem atendidos pelos projetos:

Requisitos obrigatórios Requisitos desejáveis

•	 Bacia hidrográfica como unidade de gestão 

e planejamento.

•	 Diagnóstico socioambiental prévio da 

bacia, sempre associado aos planos de 

bacia, onde houver.

•	 Atuação no âmbito da propriedade rural.

•	 Adesão voluntária dos produtores rurais.

•	 Estruturação técnica, financeira e de gestão 

por meio de parcerias institucionais.

•	 Diversificação e complementaridade das 

intervenções em campo.

•	 Estímulo às práticas sustentáveis de 

produção.

•	 Uso do Pagamento por Serviços Ambientais 

como estratégia de permanência das 

intervenções em campo.

•	 Plano de monitoramento de resultados e 

comunicação.

1.2	 Histórico

Desde o ano de 2005, o Programa tem induzido, em todo o Brasil, a implantação de projetos de 

revitalização de bacias, disseminando os conceitos e a aplicação de práticas conservacionistas com efeito 

indutor e contribuindo com a melhoria dos serviços ecossistêmicos e com o aumento da resiliência local 

frente aos eventos hidrológicos críticos, cada vez mais frequentes em função das mudanças do clima. O 

uso dos recursos da cobrança, bem como a sua aplicação em áreas particulares no âmbito dos projetos 

apoiados pelo Programa, foi objeto de verificação e aprovação quanto à legalidade e pertinência. O Programa 

demonstrou, desde sua concepção, ter grande potencial de atratividade, capaz de agregar diversos parceiros 

e de captar significativos recursos financeiros para a execução das ações. Da mesma forma, despertou 

imediato interesse em veículos de imprensa, da comunidade científica e na sociedade em geral, tendo em 

vista que se tratava da primeira iniciativa de Pagamentos por Serviços Ambientais (PSA) no Brasil.

O fato de o Programa ser de adesão voluntária, com foco no produtor rural, prezando pela harmonia 

entre produção agrícola e a conservação ambiental nas propriedades rurais, contribuiu para o sucesso 

observado. Além disso, o Programa Produtor de Água apoia a execução descentralizada, na qual parceiros 

locais desempenham papel protagonista. Este aspecto despertou maior disposição por parte de estados, 

municípios e organizações ambientais, na criação de projetos com maior capacidade de superar eventuais 

dificuldades ou entraves técnicos, políticos ou administrativos.
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As expectativas da ANA confirmaram-se logo na fase inicial de funcionamento do Programa. Um 

exemplo emblemático é o ocorrido nas bacias hidrográficas dos Rios Piracicaba, Capivari e Jundiaí (PCJ). 

Com o início da cobrança pelo uso da água nessas bacias, viabilizou-se a destinação de parte dos recursos 

arrecadados para o financiamento do Programa. Assim, em 2006, foi iniciada a primeira experiência prática 

do Programa Produtor de Água, em Extrema (MG). Diversos parceiros uniram-se à ANA na gestão do projeto, 

como a Secretaria de Meio Ambiente de São Paulo, a Coordenadoria de Assistência Técnica Integral (CATI-

SP), a The Nature Conservancy – TNC, a Prefeitura Municipal de Extrema e a Agência das Bacias PCJ.

Em 2009, foi lançada a primeira versão do Manual Operativo do programa, no qual a ANA manifestava 

a possibilidade de que os interessados apresentassem seus projetos através de demandas espontâneas. Em 

vários casos, os projetos tinham interesse apenas na implantação de ações de conservação de água e solo, 

mas careciam de arranjos de governança e de previsão de PSA. Quando considerado cabível e havendo 

disponibilidade de recursos, a ANA prestava apoio técnico e até mesmo financeiro. O foco do Programa, 

nesta fase, foi buscar um efeito demonstrativo, ampliar sua capilaridade e alcançar resultados concretos das 

ações de intervenção em nível de propriedade rural - especialmente na redução do aporte de sedimentos 

às calhas de rios e aumento dos volumes de recarga hídrica.

A partir de 2013, com a publicação da segunda versão do Manual Operativo, por meio da Portaria 

ANA nº 196, de 30 de agosto de 2013, a ANA manteve o atendimento a demandas espontâneas em áreas 

estratégicas para a obtenção do efeito demonstrativo desejado, passando também a realizar chamamentos 

públicos, por meio de editais, para seleção de projetos a serem reconhecidos e/ou apoiados, inclusive com 

aporte financeiro.

Como resultado dessa primeira fase do Programa Produtor de Água, aproximadamente 200 (duzentas) 

iniciativas foram trazidas à ANA, das quais, nos anos seguintes, mais de 60 (sessenta) projetos foram 

implantados, em todas as regiões brasileiras. 

A partir das experiências acumuladas na primeira fase do Programa, alguns aspectos foram detectados 

e diagnosticados pela equipe da ANA, bem como por estudos e pesquisas externas, como prováveis causas 

de maior sucesso de determinados projetos em relação a outros. Esse conhecimento permitiu estabelecer 

cenários mais fidedignos sobre as demandas prioritárias dos atores interessados em implantar projetos.

Diante da experiência adquirida e da crescente demanda por apoio a novos projetos, consolidou-se o 

entendimento de que o Programa atingiu maturidade, relevância e efeito demonstrativo suficientes para ser 

conduzido de forma ainda mais descentralizada, com o protagonismo de comitês de bacias hidrográficas, 

agências de água e órgãos estaduais de recursos hídricos, alinhando-se às ações prioritárias previstas nos 

planos de bacias.

A partir da Resolução ANA nº 180, de 18 de janeiro de 2024, que aprovou as novas Diretrizes do Programa, 

a ANA passou a priorizar o apoio às instâncias do Sistema Nacional de Gerenciamento de Recursos Hídricos 

(Singreh) na condução da implantação e acompanhamento de projetos em áreas prioritárias definidas nos 

planos de bacia. Para isso, a Agência reforçará suas estratégias de capacitação, de apoio institucional, de 

divulgação de resultados, de reconhecimento e integração de iniciativas exitosas e de busca por parceiros 

e fontes para o aporte de novos recursos. 

Para o efeito multiplicador pretendido, e conforme mencionado, uma das estratégias da ANA trata 

do reconhecimento de programas e projetos de conservação de água para composição do portfólio do 

Programa Produtor de Água, processo que foi regulamentado pela Resolução ANA n° 181, de 19 de janeiro 

de 2024. Além dos programas e projetos reconhecidos no Anexo I da Resolução ANA n° 181/2024, que 

devem enviar informações atualizadas anualmente para a manutenção do reconhecimento, a estratégia 

multiplicadora da ANA inclui a publicação de editais de chamamento e demais instrumentos convocatórios.
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1.3	 Manuais do Programa Produtor de Água

A partir da experiência adquirida até o momento e da definição da metodologia de trabalho do 

Programa Produtor de Água, a ANA decidiu lançar uma série de Manuais com o objetivo de compartilhar 

com os interessados o conhecimento acumulado ao longo do tempo no apoio à implantação de projetos, 

conforme apresentado a seguir:

Vol. 1 – Manual de Estruturação de Projetos;

Vol. 2 – Manual de Elaboração de Diagnósticos no Programa Produtor de Água;

Vol. 3 – Manual de Elaboração de Projeto Individual de Propriedade;

Vol. 4 – Manual de Práticas Vegetativas para Conservação de Solos e Recursos Hídricos;

Vol. 5 – Manual de Práticas Mecânicas para Conservação de Solos e Recursos Hídricos; e

Vol. 6 – Manual de Práticas Edáficas para Conservação de Solos e Recursos Hídricos

O Volume 3 da série de manuais do Programa Produtor de Água é dedicado à elaboração do 

Projeto Individual de Propriedade (PIP), considerado a unidade central de planejamento das ações de 

conservação e manejo ambiental no contexto dos projetos do Programa Produtor de Água. O manual orienta 

tecnicamente a elaboração de PIPs com base em diagnósticos integrados, valoração dos serviços ambientais 

e pactuação com produtores rurais, tendo como objetivo garantir a eficácia das práticas conservacionistas 

implementadas e a remuneração adequada por meio de PSA. Organizado de forma didática, o documento 

sistematiza metodologias já aplicadas em campo, experiências acumuladas e diretrizes legais, oferecendo 

um caminho estruturado para técnicos e gestores na condução dessas etapas. 

A publicação está dividida em três grandes seções: a primeira apresenta os fundamentos conceituais 

do Programa e do PIP, incluindo os princípios do PSA; a segunda trata do planejamento prévio à elaboração 

do PIP, abordando as etapas de implantação do projeto, definição de regras e critérios, infraestrutura técnica 

e institucional necessária; e a terceira seção detalha, passo a passo, o processo de elaboração do PIP, desde 

o diagnóstico da propriedade até sua pactuação, execução e monitoramento. O manual ainda traz anexos 

úteis com modelos de documentos e termos de referência, assegurando aplicabilidade prática e coerência 

metodológica em diversos contextos territoriais e institucionais.
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2	 O PROJETO INDIVIDUAL DE PROPRIEDADE (PIP)
O Programa Produtor de Água, conforme referido, foi criado pela ANA com o objetivo de promover 

projetos locais de conservação de recursos hídricos no Brasil. 

Foto 1 – Rio Balsas (TO)
Rui Faquini/Banco de imagens da ANA

As ações dos projetos locais são voltadas ao estímulo a produtores rurais que se proponham 

voluntariamente a adotar e permitir a adoção de práticas e manejos conservacionistas de água e solo em 

suas propriedades, tais como: a construção de terraços e de bacias de infiltração, adequação de estradas de 

terra, recuperação e proteção de nascentes, recomposição e conservação florestal, saneamento rural, entre 

outros.

As práticas conservacionistas de água e solo são tecnologias sistêmicas que visam preservar 

e recuperar os recursos naturais através do manejo integrado do solo, água e biodiversidade. 

Estas podem ser divididas em três categorias principais: Vegetativas, Edáficas e Mecânicas.

Para obter informações detalhadas sobre as características, formas e métodos para 

implementação das práticas, acesse os seguintes links dos manuais específicos criado nesta 

série de manuais do Programa Produtor de Água1:

•	 Volume 4 – Manual de Práticas Vegetativas [hiperlink]

•	 Volume 5 – Manual de Práticas Mecânicas [hiperlink]

•	 Volume 6 – Manual de Práticas Edáficas [hiperlink]

A implantação dessas práticas exige, dentre outros, um planejamento em nível de propriedade 

por meio, por exemplo, de projetos executivos. De modo geral, projetos executivos para adequação de 

propriedades rurais são voltados para a regularização e o planejamento de propriedades rurais com base 

nas exigências legais, especialmente as estabelecidas na Lei de Proteção da Vegetação Nativa (Lei nº 

12.265/2012) - também conhecida como Novo Código Florestal Brasileiro - e nas melhores práticas de 

manejo sustentável. 

Esses projetos executivos incluem um diagnóstico detalhado da propriedade e um plano de ação 

personalizado, com cronogramas, orçamentos e etapas claras para implementação das práticas de adequação 

ambiental, garantindo que a propriedade esteja em conformidade com a legislação e contribuindo para a 

preservação do meio ambiente (Schäffer; Dick; Prochnow, 2022).

1	 https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua (visita em 29/09/2025)

https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
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No contexto dos projetos e do Programa Produtor de Água, o projeto executivo da propriedade é 

denominado Projeto Individual de Propriedade (PIP). No PIP, cada propriedade rural é objeto de um estudo 

diagnóstico individualizado com utilização de ferramentas de geoprocessamento para cálculo e delimitação 

das áreas, caracterização do uso do solo, além da identificação das características naturais e das exigências 

de proteção e recuperação previstas em mecanismos legais de adequação ambiental (ANA, 2025).

Foto 2 – Projeto Produtor de Água no Rio Camboriú (SC)
Andre Targa Cavassani / Banco de Imagens ANA

O PIP pode ser entendido como um equivalente ao projeto executivo tradicional de adequação 

ambiental, porém com especificidades alinhadas às bases conceituais do Programa Produtor de Água. Essas 

bases destacam:

•	 Conservação dos recursos hídricos – consideram-se práticas de conservação do solo que 

promovam a infiltração de água, evitando processos erosivos e a consequente degradação 

e o assoreamento dos corpos hídricos, contribuindo para a manutenção da qualidade e 

quantidade da água;

•	 Produção sustentável – são consideradas técnicas de manejo do solo que promovem a 

exploração econômica sustentável da propriedade, com ênfase no uso produtivo e na 

viabilidade da produção agrícola ou pecuária, respeitando os limites do ecossistema local; e,

•	 Cálculo do PSA – define o valor equivalente ao Pagamento pelos Serviços Ambientais 

proporcionados pelas práticas adotadas na propriedade rural, sob a guarda do proprietário ou 

produtor rural.

Ou seja, além de ser um projeto de adequação hidroambiental, o PIP é o instrumento base para o cálculo 

dos Pagamentos pelos Serviços Ambientais, capaz de mensurar e quantificar, de modo compreensível, as 

ações necessárias para maximização da geração de serviços ambientais na propriedade (ANA, 2025).

O PIP é o instrumento de planejamento da propriedade rural para conservação do 

solo e dos recursos hídricos, que documenta as boas práticas adotadas pelo produtor 

rural e sua respectiva valoração financeira, dando destaque ao projeto de exploração 

econômica que o produtor pretende adotar futuramente em sua propriedade.
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O processo de elaboração do PIP é dividido em duas etapas: o PIP Ideal e o PIP Pactuado.

O PIP Ideal busca a máxima adequação hidroambiental da propriedade, conforme as diretrizes do 

projeto e a legislação vigente. Ele é apresentado ao proprietário ou produtor para negociação, podendo ser 

aceito total ou parcialmente. Este documento deve ser objetivo, com informações concisas, focando nas 

propostas para uso futuro da propriedade.

O PIP Pactuado é elaborado após a negociação, refletindo o acordo entre as partes sobre as 

intervenções a serem implementadas. Ele é a base para o cálculo dos valores de PSA, elaboração de contratos, 

implementação de práticas conservacionistas e monitoramento dos serviços ambientais prestados. 

Embora o PIP Ideal e o PIP Pactuado sejam etapas distintas, eles fazem parte de um único processo. 

O PIP Ideal apresenta as propostas de possibilidades de adequação, e, após a negociação, é ajustado para 

se tornar o PIP Pactuado.

Após assinatura do contrato, as ações e práticas são implementadas e verificadas a partir das visitas de 

monitoramento em intervalos regulares, definidos em cada projeto. Após primeira vistoria, caso as práticas 

previstas no cronograma de atividades tenham sido implementadas adequadamente, os pagamentos são 

realizados de maneira proporcional à execução.

Alguns casos podem exigir a necessidade de ajuste do PIP Pactuado. Isso pode acontecer quando há 

um longo período entre a assinatura do contrato e a implantação das práticas. Nesse longo período pode 

ocorrer a troca de titularidade da terra ou até mesmo a desistência dos acordos firmados no momento 

de assinatura de contrato. Essas situações exigem a repactuação das práticas e, consequentemente, a 

necessidade de ajustes do PIP Pactuado.

É importante destacar que os cálculos dos valores de PSA podem não se aplicar a todos os PIPs. Em 

algumas situações, os PIPs são elaborados sem a previsão de pagamento. Nestes casos, o objetivo pode ser 

a adequação legal ou a melhoria da produtividade, sem a contrapartida financeira do PSA. Isso ocorre, por 

exemplo, quando as ações visam a atender exigências regulatórias ou compromissos voluntários do produtor, 

ou ainda quando o financiamento disponível não contempla o Pagamento por Serviços Ambientais, mas 

oferece suporte técnico e estrutural para a implementação das práticas.

2.1	 O Pagamento por Serviços Ambientais (PSA)

O Pagamento por Serviços Ambientais (PSA) é um instrumento econômico que recompensa 

financeiramente as práticas conservacionistas para promoção e preservação de ecossistemas, como a 

proteção de recursos hídricos, controle da erosão e manutenção da biodiversidade (MMA, 2017). Pode 

ser entendido como uma transação voluntária entre quem presta e quem se beneficia dos serviços 

ecossistêmicos (Wunder, 2005). 

No Brasil, o PSA foi incorporado à Lei de Proteção da Vegetação Nativa, também conhecida como 

Novo Código Florestal (Lei nº 12.651/2012), e regulamentado pela Lei 14.119/2021, que instituiu a Política 

Nacional de PSA. Mesmo antes dessas leis, estados e municípios já desenvolviam iniciativas pioneiras, como 

o projeto Conservador das Águas em Extrema (MG). O financiamento pode ser público ou privado, com 

destaque para ações em bacias hidrográficas onde comitês de bacia utilizam a cobrança pelo uso da água 

para remunerar os produtores rurais.
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3	 PLANEJANDO O PROJETO INDIVIDUAL DE PROPRIE-
DADE
A etapa de elaboração do PIP representa o início da fase de execução de um projeto Produtor de 

Água, estabelecendo como as ações planejadas serão implementadas, mensuradas e monitoradas. Isso 

pressupõe que todas as etapas iniciais de implantação do projeto Produtor de Água estejam concluídas ou, 

no mínimo, bem estruturadas, e que os critérios e diretrizes de execução do projeto estejam definidos.

Dessa forma, nesta seção serão abordados os seguintes temas essenciais para o planejamento e 

elaboração eficaz do PIP:

Características e objetivos das etapas de implementação do projeto Produtor de Água, com 

ênfase nas etapas que antecedem a elaboração do PIP;

Regras e critérios para execução do projeto que devem ser estabelecidos para assegurar que 

a elaboração do PIP ocorra de maneira fundamentada e eficaz; e,

Orientações sobre conhecimentos, requisitos técnicos e recursos tecnológicos necessários 

para a elaboração do PIP, garantindo qualidade e precisão no processo.

3.1	 Etapas prévias à elaboração do PIP 

A implantação de um projeto Produtor de Água resulta a partir de um problema ambiental diagnosticado, 

da ação de um conjunto de atores que se organiza, estabelece um projeto e atua nos limites daquela bacia 

hidrográfica. As propriedades rurais contidas nesta bacia são as unidades territoriais de intervenção, que 

receberão um projeto executivo – o Projeto Individual de Propriedade – estabelecendo quais ações devem 

ser implementadas e quais os valores do PSA serão recebidos (ANA, 2025). No esquema abaixo é possível 

visualizar as principais fases e etapas de implantação de um projeto Produtor de Água.

Foto 3 – Projeto Pipiripau (DF)
Dirceu de Oliveira Costa / Banco de imagens ANA

Conforme Figura 1, as sequências prévias à elaboração do PIP envolvem a identificação de um 

problema relacionado à água, como conflitos de uso, baixa qualidade, escassez hídrica ou altos custos de 

tratamento; a mobilização de parceiros interessados em discutir soluções colaborativas, preferencialmente 

embasadas em dados obtidos em instrumentos de macroplanejamento. Também, inclui a elaboração do 
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Diagnóstico Socioambiental da bacia hidrográfica, um estudo sistematizado que fornece subsídios para o 

planejamento e execução do projeto, detalhado nessa série de manuais, no Volume 2 – Diagnóstico no 

Programa Produtor de Água [hiperlink].

Figura 1 - Fases e etapas de implantação de um Projeto Produtor de Água.
Fonte: Renato Atanazio, baseado em ANA (2025).

A etapa seguinte busca estabelecer o arranjo institucional e o modelo de governança, com destaque 

para a Unidade de Gestão do Projeto (UGP). Essa etapa é de suma importância para a gestão eficiente de 

um Projeto Produtor de Água. Dentre outros, o papel da UGP inclui a definição das regras e critérios de 

participação no projeto. Como a adesão dos proprietários das áreas é voluntária, é importante que as regras 

e benefícios da participação estejam bem definidos e comunicados a todos (ANA, 2025). 

Por fim, é necessário mobilizar e informar os produtores rurais da área sobre o projeto, começando nas 

primeiras discussões e mantendo o engajamento ao longo de sua implementação. Técnicos extensionistas, 

geralmente de instituições locais de extensão rural, realizam essa mobilização por meio de visitas às 

propriedades, palestras, reuniões, dias de campo e interações entre vizinhos (Foto 4).

https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
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Foto 4 – Ações de mobilização de proprietários rurais (GO)
Andre Targa Cavassani / Banco de Imagens ANA

Os editais de chamamento são amplamente utilizados para oficializar a mobilização dos proprietários 

e garantir transparência quanto às regras e critérios para participação no projeto. Após o lançamento do 

edital, os proprietários interessados se inscrevem no órgão responsável e aguardam o contato dos técnicos 

para fornecer informações adicionais e agendar uma visita às suas propriedades. Com base nos critérios 

de elegibilidade, previamente definidos pela UGP, a instituição executiva avalia as informações e aprova a 

adesão das propriedades ao projeto. 

Na sequência, apresentam-se informações básicas sobre as etapas prévias a elaboração dos PIPs.

3.2	 Definições das regras e critérios para o projeto e sua relação com o PIP

O Volume 1 desta série de manuais do Programa Produtor de Água, referente à Estruturação de Projetos, 

fornece diretrizes para a execução de projetos que podem ser adaptadas de acordo com o contexto local 

de cada região e estrutura financeira de cada projeto. Responsável pela coordenação e gestão do projeto, 

a UGP adapta as diretrizes gerais do programa às especificidades locais, considerando as características 

ambientais, sociais e econômicas da região, bem como os aspectos jurídicos e legais aplicáveis à execução 

do projeto.

Essa adaptação exige a discussão e definição de regras e critérios que orientam as atividades de 

execução do projeto, entre elas as atividades necessárias a elaboração do PIP. Para garantir a transparência 

e o respaldo jurídico, é essencial formalizar essas regras e diretrizes por meio de instrumentos adequados, 

como leis, decretos, editais de chamamento, entre outros documentos de referência com as definições 

gerais do projeto.

É recomendável a criação de um documento de referência, que serve como um 

manual de instruções e regras para execução do projeto. Este pode ser incluído como 

anexo dos editais de chamamento dos proprietários, bem como de editais ou contratos 

realizados para a contratação de terceiros para elaboração dos PIPs, garantindo que as 

diretrizes e regras estejam claras para todos os envolvidos no projeto. A flexibilidade 

destes documentos permite atualizações conforme novas necessidades surgem, 

garantindo a evolução e adequação contínua do projeto.
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A seguir estão apresentadas algumas regras e critérios que devem estar definidos previamente à fase 

de elaboração do PIP. O objetivo é trazer o entendimento básico sobre as principais definições necessárias 

e como cada uma delas influencia diretamente na formulação destes projetos executivos das propriedades, 

os PIPs. Os principais assuntos quanto aos critérios apresentados foram segmentados desta forma:

Diretrizes e critérios operacionais - objetivos, prioridades e critérios de participação, priorização 

e contratação;

Aspectos legais e regulatórios aplicáveis ao PIP; e,

Práticas elegíveis, requisitos técnicos e infraestrutura tecnológica.

3.2.1	 Diretrizes e critérios operacionais

Objetivos e prioridades do projeto

Refere-se à especificação do projeto, sendo as primeiras macrodefinições que orientarão os demais 

critérios e regras. Aqui são estabelecidos quais são os objetivos específicos do projeto, a justificativa para 

sua implantação e quais são as ações prioritárias para atacar o problema identificado nas suas fases iniciais, 

bem como nos resultados de estudos como o diagnóstico socioambiental da bacia.

O objetivo principal de projetos Produtor de Água é promover a conservação e a recuperação de 

recursos hídricos por meio da adoção de práticas de manejo sustentável e conservação ambiental em 

propriedades rurais. No entanto, outros objetivos específicos podem ser estabelecidos, como por exemplo:

•	 Proteger as áreas sujeitas a restrição de uso com vistas à proteção dos recursos hídricos;

•	 Aumentar a purificação da água, a regulação da vazão e a redução da sedimentação; e,

•	 Recuperar os cursos d’agua que apresentem acelerado processo de assoreamento e erosão 

de suas margens, entre outros.

É importante que os objetivos estejam claros e alinhados à resolução dos problemas da bacia 

hidrográfica, pois são os elementos norteadores para definição das principais práticas elegíveis a serem 

adotadas nas propriedades, bem como dos critérios e seus pesos de acordo com sua importância na 

avaliação e valoração dos serviços ambientais.

Critérios de elegibilidade e condições para participação

São as exigências mínimas para participação do projeto, especificando as condições que os 

proprietários ou produtores responsáveis pelas terras devem atender para se qualificarem aos benefícios do 

projeto. Considera-se aqui a documentação necessária que habilitam o proprietário/possuidor da área, bem 

como outros critérios técnicos que devem estar alinhados aos objetivos do projeto, como por exemplo:

•	 Estar total ou parcialmente inserida na área geográfica de execução do projeto;

•	 Possuir área mínima de “X” hectares (como forma de não contribuir com o parcelamento da 

terra); e,

•	 Existência de Cadastro Ambiental Rural (CAR) homologado; entre outros.
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Além das condições para participação, importante também estar claro quais são os possíveis 

impedimentos a participar, que geralmente envolvem questões administrativas e jurídicas acerca do perfil 

do proprietário e da área, como por exemplo:

•	 Declarada inidônea ou impedida de licitar e contratar com a administração pública direta ou 

indireta, enquanto perdurarem os efeitos da sanção; e,

•	 A quem tenha relação de parentesco com dirigentes de empresa pública ou empregado da 

instituição responsável pelos contratos e pagamentos do PSA; entre outros.

Importante destacar que esses critérios devem filtrar e organizar a demanda de propriedades 

potenciais participantes do projeto, porém, sem inviabilizar a participação da maioria. Quanto mais critérios 

estabelecidos, mais alto o nível de exigência e restrição à participação. 

O nível de exigência pode variar muito e deve ser definido de acordo com as recomendações feitas 

pelos departamentos jurídicos (ou procuradorias, no contexto de municipalidades) das instituições com as 

quais os proprietários firmarão contrato. 

Quando esses critérios envolvem questões jurídicas rigorosas, como por exemplo, a exigência de 

comprovação da titularidade da terra, pode inviabilizar a participação de muitas propriedades, impactando 

diretamente os resultados do projeto, especialmente quando há restrições na participação de propriedades 

em áreas consideradas prioritárias pelo ponto de vista hidroambiental.

Critérios de priorização para contratação das propriedades

São critérios que avaliam a propriedade dentro dos objetivos e prioridades estabelecidos para o projeto, 

definindo quais propriedades terão prioridade na contratação. Essa classificação e o estabelecimento de um 

ranking dentro do universo de propriedades cadastradas (que cumpriram os critérios de elegibilidade) que 

permite saber por onde começar as contratações, além de estabelecer critérios de desempate no caso de a 

procura pelo projeto ser maior do que a disponibilidade financeira ou por limitações técnicas de execução. 

São exemplos de critérios de priorização:

•	 Propriedades localizadas em bacias ou sub-bacias abastecedoras de sistemas públicos de 

fornecimento de água para consumo humano ou contribuintes de reservatórios; 

•	 Propriedades com maior potencial de diminuição de processos erosivos, redução de 

sedimentação, aumento da infiltração de água no solo, melhoria da qualidade e quantidade 

de água e constância do regime de vazão; e,

•	 Áreas que possibilitem a formação de corredores de biodiversidade; entre outros.

Além dos critérios técnicos, recomenda-se também estabelecer critérios que priorizem, por exemplo, 

a contratação de proprietários ou produtores que atuem como lideranças na região e possam servir de 

exemplo para outros interessados. Contudo, é importante verificar com a área jurídica da instituição 

responsável pelos contratos e pagamentos a possibilidade e viabilidade de adoção desse tipo de critério.

Importante ressaltar que deve ser definido um grupo de critérios que sejam exequíveis por parte das 

instituições envolvidas, considerando a capacidade técnica e dados disponíveis sobre a região de estudo. 

Caso contrário, pode inviabilizar ou burocratizar demasiadamente a execução do projeto.

Papéis e responsabilidades para elaboração do PIP 

Refere-se aos papeis e como as atividades de elaboração e aprovação dos PIPs são divididos entre 

as instituições envolvidas na execução do projeto. Geralmente estas responsabilidades estão definidas de 

forma ampla no Acordo de Cooperação Técnica (ACT) – ou outros pactos - firmados quando da oficialização 
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da UGP. Porém, há necessidade de especificação detalhada de cada etapa e atividade de todo o processo 

de elaboração dos PIPs.

As diferentes atividades podem ser compartilhadas ou divididas entre as instituições envolvidas no 

arranjo institucional de acordo com suas áreas de atuação e a disponibilidade de corpo técnico, ou, em 

alguns casos, contratadas. Os PIPs, por exemplo, podem ser elaborados diretamente por uma das instituições 

que compõe o arranjo institucional de gestão do projeto ou ainda por empresas contratadas para este fim.  

Os procedimentos para elaboração dos PIPs também devem ser previamente definidos para orientar 

as atividades de elaboração e aprovação dos PIPs e estão atrelados diretamente às instituições responsáveis 

pela execução. 

A terceira seção deste manual, que trata da parte prática de elaboração do PIP, pode ser utilizada 

como referência para estas definições, com as devidas adequações às condições do projeto.

3.2.2	 Aspectos legais e regulatórios 

A elaboração dos PIPs deve considerar um conjunto de legislações ambientais, fundiárias e 

administrativas para garantir que as práticas de conservação e recuperação nas propriedades rurais estejam 

em conformidade com a legislação vigente. Essas normas não apenas oferecem respaldo jurídico, como 

também asseguram a viabilidade legal e a sustentabilidade ambiental do projeto, garantindo que os 

proprietários rurais e as instituições envolvidas atuem dentro dos limites legais e obtenham os benefícios 

esperados. 

Destacam-se aqui os dispositivos de proteção previstos na Lei de Proteção da Vegetação Nativa e as 

Instruções Normativas relativas ao CAR, instrumento utilizado por muitos projetos do Programa Produtor 

de Água para coleta e uso de informações georreferenciadas. Abaixo estão as principais legislações que 

devem ser consideradas:

•	 Lei de Proteção da Vegetação Nativa - Lei nº 12.651/2012 (BRASIL, 2012): Popularizada pelo 

nome de Novo Código Florestal Brasileiro esta lei é essencial para a elaboração dos PIPs, pois 

define as regras de proteção ambiental que devem ser seguidas pelos proprietários rurais. 

Define Áreas de Preservação Permanente (APP) e de Reserva Legal (RL), que desempenham 

um papel crucial na proteção de nascentes, cursos d’água e vegetação nativa, essenciais para 

a manutenção dos ciclos hidrológicos;

Figura 2 - Áreas de Preservação Permanente hídrica, segundo a Lei n° 12.651/2012.
Fonte: Schäffer; Dick; Prochnow (2022).
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Além das regras e critérios estabelecidos no artigo. 4º desta lei, há de se considerar 

também as orientações previstas no Art. 61-A, que trata das regras transitórias de 

necessidade de recomposição de vegetação em áreas consideradas “consolidadas” 

(existentes antes da data de 22 de julho de 2008) de acordo com a tipologia da APP e 

tamanho do imóvel.

Para obter mais detalhes sobre este assunto e sobre as características da demais 

tipologias de APP, acesse o Volume 4 sobre Práticas Vegetativas desta série de manuais, 

por este link. [hiperlink]

•	 Instruções Normativas do Cadastro Ambiental Rural: As Instruções Normativas (IN) do CAR 

são fundamentais para a elaboração de PIPs, pois orientam sobre a regularização ambiental 

das propriedades rurais, conforme a Lei de Proteção da Vegetação Nativa. As IN nº 2/2014 

e nº 3/2014, do Ministério do Meio Ambiente (MMA), atual Ministério do Meio Ambiente e 

Mudança do Clima, estabelecem diretrizes para a inscrição das áreas de preservação no CAR 

e a inserção de dados no Sistema Nacional de Cadastro Ambiental Rural [SiCAR] (Decreto nº 

7.830/2012); 

•	 Legislações locais: Também é necessário considerar normas e regulamentos locais emitidos 

por órgãos estaduais e municipais, como:

•	 Sistemas locais e estaduais complementares ao CAR, como o CEFIR (BA), o SICAR (SP), 

SICAR (PR), o SIMCAR (MT), entre outros sistemas que geram recomendações e orientações 

relacionadas à adequação ambiental da propriedade, à conformidade com a legislação e à 

necessidade de ações de regularização. 

•	 Legislação Estadual e Municipal de Recursos Hídricos: Algumas unidades da federação 

possuem suas próprias leis de gestão de recursos hídricos e Pagamento por Serviços 

Ambientais que devem ser observadas no âmbito local; e,

•	 Normas de Conservação do Solo e Água: Estados e municípios podem ter programas e 

regulamentações específicas para a conservação de solo e água, que complementam as 

diretrizes nacionais.

Além das normas discutidas acima, a elaboração dos PIPs envolve indiretamente outras legislações 

ambientais, fundiárias e administrativas que devem ser consideradas para oferecer respaldo jurídico e 

assegurar a viabilidade legal e a sustentabilidade ambiental do projeto: 

•	 Política Nacional de Pagamento por Serviços Ambientais (PNPSA) - Lei nº 14.119/2021 (BRASIL, 

2021): estabelece a PNPSA e regulamenta os incentivos financeiros aos proprietários rurais que 

adotam práticas de conservação ambiental. Embora muitos dos projetos Produtor de Água 

tenham sido desenvolvidos antes da aprovação desta norma, trata-se de uma Política Nacional 

de PSA que teve seu texto influenciado a partir das experiências do Programa Produtor Água. 

No contexto do PIP, a lei pode influenciar novos projetos, especialmente sobre as disposições 

referentes à formalização de contratos ou termos de adesão entre o proprietário e a instituição 

responsável pelo projeto, pode ser feita em conformidade com essa legislação. 

•	 Política Nacional do Meio Ambiente - Lei nº 6.938/1981 (BRASIL, 1981): estabelece os princípios 

e mecanismos para a preservação, melhoria e recuperação da qualidade ambiental no Brasil. 

No contexto do PIP, dependendo das intervenções planejadas (ex.: construção de barragens ou 

https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
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manejo de terras), pode ser necessário o licenciamento ambiental, conforme regulamentação 

dos órgãos estaduais ou municipais de meio ambiente. 

•	 Política Nacional de Agricultura Familiar - Lei nº 11.326/2006 (BRASIL, 2006): define os 

critérios para o enquadramento de produtores rurais como agricultores familiares. No caso de 

pequenos produtores que aderem ao projeto, pode levar em consideração as especificidades 

da agricultura familiar e as políticas de incentivo voltadas para esse grupo. A lei define o direito 

de agricultores familiares a programas de apoio técnico e financeiro, que podem ser relevantes 

para complementar as ações previstas no PIP. 

•	 Legislação sobre Regularização Fundiária - Lei nº 13.465/2017 (BRASIL, 2017): estabelece 

diretrizes para a regularização e diretrizes sobre parcelamento do solo de propriedades rurais 

e urbanas que poderão ser adotados ou não pelos projetos.

•	 Lei de Licitações e Contratos - Lei nº 14.133/2021 (BRASIL, 2021b): estabelece normas gerais 

de licitação e contratação para as Administrações Públicas diretas, autárquicas e fundacionais 

da União, dos Estados, do Distrito Federal e dos Municípios. Caso o projeto seja executado 

com o auxílio de contratação de empresas terceirizadas para elaboração dos PIPs ou outras 

atividades, é fundamental seguir esta lei, que assegura que o processo de seleção seja justo, 

competitivo e com menor risco de irregularidades.

3.2.3	 Práticas conservacionistas elegíveis

As práticas conservacionistas de água e solo são técnicas sistêmicas que visam preservar e recuperar 

os recursos naturais através do manejo integrado do solo, água e biodiversidade. Estas práticas são essenciais 

para a preservação dos recursos naturais e sua implementação nas propriedades rurais pode ser beneficiada 

pela valoração dos serviços ambientais a partir das modalidades de PSA.

As práticas mais adequadas são eleitas com base no atendimento aos objetivos do projeto estabelecidos 

para resolver o problema identificado na bacia hidrográfica (Figura 3). 

Cada prática gera benefícios mensuráveis que devem ser correlacionados com os pagamentos 

de maneira transparente e justa. Tendo clareza de quais práticas deverão ser adotadas para resolver os 

problemas do projeto, essas devem ser vinculadas aos critérios de valoração utilizados nos cálculos e às 

modalidades de PSA.

Figura 3 - Relação entre problema, objetivos e práticas elegíveis como intervenções para minimizar o problema.
Fonte: Renato Atanazio.
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Convém sempre ter em mente que não existem práticas isoladas de conservação do solo e da água, 

devendo-se considerar que apenas um conjunto delas promoverá resultados satisfatórios (ANA, 2025). Elas 

podem ser divididas em três categorias principais, conforme apresenta a Tabela 1.

Tabela 1 - Práticas conservacionistas de água e solo do Programa Produtor de Água2

Práticas Vegetativas Práticas Edáficas Práticas Mecânicas

Consiste na utilização da vegetação 

para proteger e melhorar a qualidade do 

solo, conservando simultaneamente os 

recursos hídricos. Estas técnicas trazem 

múltiplos benefícios, desde a melhoria 

da fertilidade do solo e produtividade 

nas áreas agrícolas até a qualidade 

e quantidade de água disponível, 

contribuindo para práticas agrícolas 

sustentáveis e para a sustentabilidade 

ambiental a longo prazo.

Exemplos: plantas de cobertura, culturas 

em faixas, alternância de capinas, quebra-

ventos, sistemas de integração, sistemas 

agroflorestais, pastejo rotacionado e 

recomposição da vegetação nativa.

São técnicas utilizadas para melhorar 

a fertilidade e as condições físicas do 

solo na fase de plantio e condução da 

lavoura, possibilitando um crescimento 

rápido e sadio das plantas. Estas técnicas 

promovem uma maior cobertura e 

proteção do solo contra a chuva, de 

formar a contribuir para o controle da 

erosão.

Exemplos: plantio direto, adubação 

verde, calagem, rotação de culturas, 

compostagem e controle de queimadas.

Referem-se às práticas que utilizam 

estruturas artificiais para a redução da 

velocidade de escoamento da água 

sobre a superfície do solo, interferindo 

nas fases mais avançadas do processo 

erosivo. Ao frear as enxurradas, as 

práticas mecânicas reduzem seu 

potencial destrutivo, conservando, 

simultaneamente, o solo e a água.

Exemplos: terraceamento agrícola, os 

diversos tipos de canais escoadouros e as 

bacias de captação, também conhecidas 

como barraginhas, cacimbas ou baciões.

As práticas mencionadas na Tabela 1 relacionam-se a um aspecto central do Programa Produtor de 

Água, isto é, a conciliação entre conservação de solo e água em áreas de produção agrícola e estradas 

rurais. Dentre elas, o terraceamento agrícola é, certamente, a mais utilizada em todo o mundo devido a 

sua grande eficiência e baixo custo, podendo ser adaptada para terrenos com diferentes características. É, 

igualmente, a prática mais utilizada em projetos do Programa Produtor de Água (ANA, 2025).

Foto 5 – Execução de terraceamento com cochinho (ES)
Marcio Menon / Banco de Imagens ANA

Inclusive, em muitos projetos, a adoção desta prática possui um peso maior no cálculo do PSA. A 

modalidade de “Conservação de Solo”, que considera o cálculo do Percentual de Abatimento de Erosão 

(PAE), quantifica a redução da perda de solo causada pela erosão em áreas agropecuárias, sendo as práticas 

mecânicas e edáficas as mais aplicáveis, porém não únicas, nessa modalidade (Chaves et al., 2004).

2	 Fonte: Renato Atanazio, baseado em ANA (2025) e Chaves et al. (2004)
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Foto 6 – Prática mecânica (barraginha) executada em estrada rural (ES)
Marcio Menon / Banco de Imagens ANA

Quanto mais eficazes forem as práticas em preservar o solo, aumentar a infiltração de água e reduzir a 

erosão, maior será o valor atribuído ao serviço ambiental prestado (ANA, 2025). Essa clareza é fundamental 

para garantir a adesão e o comprometimento dos produtores no longo prazo. 

Além das práticas apresentadas na Tabela 1, os projetos vinculados ao Programa Produtor de Água 

adotam técnicas complementares para revitalização ambiental de bacias hidrográficas, tais como as 

práticas de restauração e conservação da vegetação nativa. Estas práticas promovem benefícios ambientais 

significativos para conservação dos recursos hídricos, fornecendo uma barreira natural contra a erosão, 

filtragem de poluentes, além de contribuir para a regulação do ciclo hídrico. Para estas práticas, como 

restauração ou conservação de vegetação nativa, o PSA é calculado conforme a extensão e a integridade 

das áreas.

Foto 7 – Cercamento de APP no Projeto Produtor de Água do Rio Camboriú (SC)
Andre Targa Cavassani / Banco de Imagens ANA

Há também outras práticas complementares, como as vinculadas ao saneamento rural, que 

contribuem diretamente para a melhoria da qualidade da água ao prevenir a contaminação por efluentes 

domésticos e agrícolas. Inclui, por exemplo, a instalação de fossas sépticas e a compostagem de resíduos 

orgânicos, entre outros, que refletem na redução da poluição difusa e a melhoria da qualidade da água nas 

bacias hidrográficas.

3.2.4	 Metodologia de cálculo do PSA 

Conforme referido, o PIP é, também, quando couber, o instrumento base para o cálculo dos 

Pagamentos por Serviços Ambientais. Uma das metodologias usadas pelo Programa Produtor de Água para 



Série Manuais do Programa Produtor de Água: Vol.3 Elaboração de Projeto Individual de Propriedade

34

calcular o PSA é o Percentual de Abatimento de Erosão (PAE). Essa metodologia é baseada no princípio da 

proporcionalidade. Tendo em vista os usos múltiplos da terra, adaptações são necessárias, desdobrando-se 

em modalidades específicas de PSA.

Ao aplicar mais de uma modalidade de PSA, cada valor deve ser calculado separadamente e somado. 

São essenciais dois elementos para isso: o Valor de Referência (VRE) e a tabela de critérios. O VRE é o 

valor base para os cálculos de cada modalidade de PSA e é fundamentado pelo conceito de custo de 

oportunidade — perdas de renda pelo uso restrito da terra, ou algum outro que pode ser definido pela UGP 

ou até mesmo pelo parceiro pagador. O VRE deve ser realista, refletir a economia local e pode ser indexado 

por parâmetros como a Unidade Fiscal Municipal (UFM) ou ainda ser definido dentro de algum instrumento 

legal local. Vale destacar que este valor de referência deve ser tal que tanto os produtores rurais quanto os 

parceiros que compõem a UGP o entendam e aceitem.

A tabela de critérios contém os índices e critérios de valoração por modalidade e deve refletir o 

problema ambiental a ser atacado dentro do projeto, valorando mais aquelas ações que poderão ser mais 

efetivas. Destaca-se que a metodologia utilizada pelo Programa Produtor de Água considera, de modo geral, 

três modalidades de PSA:

I.	 Conservação de Solo: usa o PAE e critérios como abatimento da erosão, terraços, barraginhas 

e estradas;

II.	 Restauração ou Conservação de Área de APP e RL: avalia ações de restauração, proteção, 

manutenção e conectividade das áreas; e,

III.	 Conservação de Vegetação Nativa: aplica-se a vegetação excedente à APP/RL.

A depender do problema a ser resolvido dentro da bacia, alguns projetos podem inserir outras 

modalidades vinculadas à gestão da propriedade rural assim como ações de saneamento rural e até mesmo 

práticas edáficas, tais como produção orgânica e manejo de fogo.

Para mais informações sobre cálculo de PSA considerar outros materiais e publicações do Programa 

Produtor de Água.

3.3	 Requisitos técnicos e infraestrutura tecnológica

Seguindo nesta seção de informações necessárias ao planejamento dos Projetos Individuais de 

Propriedades, este tópico traz orientações referentes aos conhecimentos e estrutura tecnológica necessária 

a elaboração destes instrumentos.

3.3.1	 Expertise e conhecimentos necessários

A elaboração dos PIPs requer uma equipe multidisciplinar que combine habilidades técnicas 

e interpessoais, dado o caráter complexo e personalizado desses instrumentos de gestão da 

propriedade. 

Quanto às competências técnicas, os profissionais envolvidos devem possuir conhecimento e 

experiências em áreas específicas, como: 

•	 Sistema de Informação Geográfica (SIG) e Geoprocessamento: para coleta de dados em 

campo, produção de mapas detalhados das propriedades rurais e manipulação de bases de 

dados, análise e interpretação de dados geográficos, utilizando software especializado para 

apoio ao planejamento das ações de conservação.
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•	 Conservação e restauração de vegetação nativa: para planejamento e definição de técnicas 

adequadas, como plantio de espécies nativas, cercamento, controle de erosão e recuperação 

de matas ciliares.

•	 Extensão rural para assistência técnica personalizada, orientando os agricultores na 

implementação de práticas sustentáveis que equilibrem a produtividade agrícola com a 

preservação dos recursos naturais, em especial os recursos hídricos.

•	 Engenharia para cálculos e definição de estratégias para retenção do escoamento da água de 

chuva e de sedimentos, a partir de práticas de adequação de estradas rurais, construção de 

terraços e barraginhas, entre outras.

O relacionamento com os agricultores é fundamental, pois o processo de elaboração do PIP é feito de 

forma colaborativa e negociada. Isso exige uma série de competências interpessoais e habilidades humanas, 

as quais geralmente são comuns aos profissionais de extensão rural, tais como:

•	 Comunicação eficaz: O profissional deve ser capaz de comunicar conceitos técnicos de forma 

clara, adaptando a linguagem ao nível de conhecimento do produtor e ao contexto cultural 

da comunidade rural.

•	 Conhecimento e respeito à cultura e tradições locais: Um profundo entendimento da cultura 

local é importante para estabelecer confiança e promover a adoção de novas práticas. 

Recomendações técnicas devem ser sensíveis às tradições e práticas econômicas locais, para 

que os produtores se sintam respeitados e compreendidos.

•	 Mediação e resolução de conflitos que podem surgir tanto entre os próprios produtores, 

quanto entre produtores e outros atores envolvidos no projeto (órgãos ambientais, governo 

etc.). O profissional precisa mediar esses conflitos de maneira pacífica e imparcial.

•	 Habilidade de negociação: O técnico deve ser capaz de negociar com o produtor, identificando 

suas necessidades específicas e propondo soluções práticas que sejam viáveis para ele, 

dentro dos objetivos do projeto. A negociação deve sempre buscar um equilíbrio entre as 

necessidades do produtor e os resultados esperados do projeto.

•	 Liderança e tomada de decisão: Em muitos casos, os técnicos assumem uma posição de 

liderança no projeto, sendo responsáveis por tomar decisões estratégicas que orientem o 

produtor em direção a uma maior sustentabilidade e produtividade.

•	 Flexibilidade e resiliência: Dada a natureza das atividades rurais, que frequentemente são 

influenciadas por fatores externos como mudanças climáticas e variações de mercado, os 

profissionais precisam ser flexíveis para ajustar estratégias conforme novas circunstâncias surgem.

3.3.2	 Infraestrutura tecnológica – Equipamentos e Softwares recomendados

A infraestrutura tecnológica, composta por equipamentos e softwares adequados, desempenha 

um papel essencial na elaboração eficiente dos PIPs. Ferramentas tecnológicas de qualidade 

não apenas aumentam a precisão dos dados coletados, mas também fortalecem a viabilidade 

e o sucesso do projeto a longo prazo, promovendo intervenções mais sustentáveis e eficazes 

(Burrough et al., 2015; Tomlinson, 2007).

Apesar disso, a flexibilidade na escolha dos recursos tecnológicos é fundamental, permitindo que 

as instituições adaptem suas operações às suas capacidades financeiras. Essa abordagem garante que os 

objetivos do projeto sejam atingidos de maneira eficiente, mesmo em cenários com recursos limitados.

Este bloco apresenta opções tecnológicas, abrangendo desde soluções robustas e de alta performance, 

ideais para um cenário mais estruturado, até alternativas acessíveis e gratuitas que, ainda assim, oferecem a 
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qualidade necessária para a elaboração dos PIPs. Assim, busca-se atender diferentes realidades operacionais, 

garantindo a viabilidade técnica e financeira das ações planejadas.

Equipamentos

Quanto aos equipamentos necessários, a elaboração dos PIPs demanda uma infraestrutura 

tecnológica capaz de apoiar atividades como planejamento, monitoramento e gestão eficiente dos dados. 

Essa infraestrutura deve incluir ferramentas apropriadas para a coleta e o processamento de informações 

geográficas, garantindo a precisão e a qualidade dos resultados. Abaixo, são apresentados os principais 

equipamentos recomendados:

•	 GNSS (Global Navigation Satellite System): Usado para o georreferenciamento das 

propriedades rurais e coleta de pontos de interesse. Equipamentos geodésicos e topográficos 

são essenciais para determinar coordenadas geográficas de forma exata, garantindo a acurácia 

posicional. No entanto, o mapeamento das propriedades para o PIP, em muitos casos, não exige 

alta precisão. Dispositivos conhecidos como GPS de navegação e aparelhos celular podem ser 

utilizados para estas atividades, especialmente aparelhos mais recentes que operam o GNSS 

na frequência L5, apresentando erros em torno de 5 metros. 

Ver na sequência, o tópico específico com aplicativos recomendados para utilização em 

aparelhos celulares, em especial as aplicações para marcação de pontos e rota em campo, 

como Qfield, Avenza Maps e GPS Logger.

•	 Câmeras fotográficas ou smartphones: utilizados para documentação fotográfica 

das propriedades, tanto no estado inicial, quanto após a implementação das práticas 

conservacionistas. A documentação visual é essencial para a criação de relatórios de 

monitoramento e avaliação. Não há necessidade de aquisição de equipamentos robustos para 

esta atividade considerando que, atualmente, smartphones dos mais simples possuem câmeras 

com qualidade satisfatória. Caso sejam utilizados smartphones, sugere-se que a tomada de 

fotografias seja realizada sempre com o celular em modo paisagem (horizontal), garantindo 

maior ângulo para a fotografia, além de permitir a utilização em relatórios posteriores. Ademais, 

sempre que possível, é preferível manter um ponto fixo para as fotografias, de modo que a 

comparação antes e após intervenção seja evidente.

•	 Notebooks e computadores: utilizados para o processamento de grandes volumes de dados 

geográficos, como imagens de satélite, análises de dados geoespaciais e elaboração de mapas 

e relatórios. Para estas funções é necessário o uso de computadores com alto desempenho 

com poder de processamento e memória suficiente para rodar softwares de geoprocessamento. 

Computadores de baixo desempenho pode ser utilizados, desde que suportem os softwares e 

aplicativos necessários para o trabalho de campo e o processamento de dados. Os pontos negativos 

são uma possível lentidão no processamento dos dados, dificuldade para rodar softwares robustos 

com versões mais atuais, além de pouca capacidade de armazenamento. De modo geral, para 

utilização de softwares de geoprocessamento, sugere-se equipamentos com, no mínimo, 16 Gb 

de memória RAM e placa de vídeo dedicada, além de SSD, ao invés dos tradicionais HDs.

•	 Infraestrutura de suporte: Destaca-se a importância também de garantir a infraestrutura de 

suporte, como conexão de internet de alta velocidade e servidores para armazenamento de 

dados, sejam eles locais ou na nuvem.

Estes são os equipamentos essenciais para elaboração de PIP que atendem às atividades de 

coleta e processamento dos dados para elaboração dos mapas, bem como para as ações de vistorias e 

monitoramento das ações propostas. No entanto, a depender da necessidade do projeto e da estrutura 
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financeira das instituições envolvidas, outros equipamentos poderão ser utilizados para busca de melhor 

precisão e qualidade das informações geradas. Tais como:

•	 Aeronaves Remotamente Pilotadas (Drones): Equipado com câmeras de alta resolução, 

são muito úteis para realizar levantamentos aéreos, mapeamento de áreas de difícil acesso 

e monitoramento de áreas de intervenção. Fornecem imagens atualizadas e detalhadas das 

propriedades, permitindo uma visualização ampla e precisa das áreas de vegetação nativa 

e das áreas produtivas com intervenções e ações implementadas com alta portabilidade e 

facilidade de operação;

•	 Equipamentos de geodésia e topografia: A elaboração dos mapas e o mapeamento das 

propriedades para o PIP não exigem, obrigatoriamente, o uso de equipamentos de geodésia 

e topografia. Contudo, é altamente recomendável sua utilização para medições precisas do 

terreno, especialmente em terrenos acidentados, bem como para a delimitação das áreas que 

receberão intervenções, como barraginhas, curvas de nível, cercamento, entre outras práticas 

conservacionistas. Esses equipamentos garantem um elevado nível de acurácia e precisão, 

garantindo a eficiência e a eficácia das ações propostas.

•	 Equipamentos de medição de quantidade e qualidade da água3: Medidores de pH, turbidez, 

oxigênio dissolvido e outros parâmetros são essenciais para o monitoramento da qualidade 

da água das nascentes e cursos d’água dentro das propriedades. Fluviômetros, vertedores 

ou calhas Parshall para medição de vazão dos rios, são equipamentos que permitem avaliar 

os impactos e resultados de disponibilidade da água a partir das práticas de conservação 

implementadas.

Foto 8 – Atividade de monitoramento de água (SC)
Andre Targa Cavassani / Banco de imagens ANA

3	 Opções equipamentos de baixo custo que atesta qualidade da água: https://jornal.usp.br/ciencias/indicado-para-comunidades-vulnera-
veis-sensor-de-baixo-custo-atesta-qualidade-da-agua/ (visita em 29/09/2025)

https://jornal.usp.br/ciencias/indicado-para-comunidades-vulneraveis-sensor-de-baixo-custo-atesta-qualidade-da-agua/
https://jornal.usp.br/ciencias/indicado-para-comunidades-vulneraveis-sensor-de-baixo-custo-atesta-qualidade-da-agua/
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Softwares e programas de geoprocessamento

Softwares de geoprocessamento e de Sistemas de Informações Geográficas (SIG) são fundamentais 

para processamento dos dados, análise espacial, planejamento das ações no projeto e criação dos mapas 

das áreas. Os principais programas sugeridos são:

QGIS: Alternativa gratuita e altamente funcional, destacando-se como uma das melhores 

opções disponíveis para geoprocessamento e análise geográfica. Ele suporta diversos formatos 

de dados, permite a criação de mapas, edição e análises avançadas, além de rodar com ótimo 

desempenho em equipamentos modestos. Seu uso no formato Geopackage, mais eficiente que 

o Shapefile (em processo de descontinuidade), melhora o armazenamento e a manipulação 

de dados. Com atualizações constantes e uma comunidade ativa, o QGIS combina robustez, 

acessibilidade e desempenho, sendo uma escolha estratégica para atender às demandas de 

geotecnologia de forma econômica e eficaz.

ArcGIS: Plataforma de SIG robusta que permite criar mapas detalhados e análises espaciais 

complexas, integrando diferentes camadas de informação componentes de bases de dados 

(uso do solo, topografia, rede hidrográfica etc.).

Google Earth Pro: Programa gratuito que permite marcação e exportação de pontos, linhas e 

polígonos, além da visualização e exportação de imagens de satélite com boa resolução, que 

oferecem uma visão ampla de propriedades e regiões de interesse. Em áreas rurais ou remotas, 

as imagens são atualizadas regularmente com resolução que   varia entre 1 e 15 metros - 

dependendo da localização e data de captura, e da disponibilidade de imagens obtidas por 

satélites comerciais e outras fontes. A data da captura pode ser verificada na parte inferior da 

tela do Google Earth.

Estes são os softwares que atendem minimamente as atividades de coleta e processamento dos dados 

para elaboração dos mapas, bem como para as ações de vistorias e monitoramento das ações propostas. 

No entanto, a depender da necessidade do projeto e da estrutura financeira das instituições envolvidas, 

outros softwares poderão ser utilizados para busca de melhor desempenho e qualidade das informações 

geradas, tais como softwares de processamento de imagens de satélite ou fotos aéreas. 

Destaca-se o Google Earth Engine (GEE), plataforma de processamento em nuvem, como uma 

alternativa poderosa para análise e manipulação de imagens de satélite. Sua ampla capacidade de 

processamento permite realizar desde a extração de imagens até análises mais complexas, como classificação 

de uso e cobertura da terra, detecção de mudanças, modelagem ambiental, entre outras aplicações. O GEE 

exige certo conhecimento em programação, porém ferramentas como o ChatGPT podem ser utilizadas 

como suporte para a criação de códigos e scripts, facilitando a curva de aprendizado e acelerando a 

execução de tarefas específicas.

Vale mencionar também softwares que auxiliam no dimensionamento de práticas mecânicas de 

conservação de solo e água, como barraginhas e terraços. Esses programas calculam volumes, declividades, 

espaçamentos, entre outros parâmetros técnicos, garantindo a eficiência das intervenções e sua adequação 

às condições locais. Detalhes podem ser obtidos no Vol. 5 – Manual de Práticas Mecânicas para Conservação 

de Solo e Água do Programa Produtor de Água [hiperlink].

Aplicativos para dispositivos móveis 

Abaixo estão sugestões de softwares e aplicativos para tablet ou aparelho celular que possuem grande 

utilidade para as atividades de campo:

https://www.gov.br/ana/pt-br/acesso-a-informacao/acoes-e-programas/programa-produtor-de-agua
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•	 QFIELD: Aplicativo de coleta de dados geoespaciais para dispositivos Android e iOS, para captura, 

visualização, edição e sincronia dos dados espaciais em tempo real ou sem a necessidade 

constante de conexão com a internet. Permite tirar fotos georreferenciadas e incluir diretamente 

no arquivo de exportação. O aplicativo tem integração com o software QGIS, que permite a 

montagem prévia de uma base de dados e acessá-la no QFIELD em campo para edição.

•	 AVENZA MAPS: Aplicativo para dispositivos Android e iOS que possibilita o acesso a mapas 

digitais, localização por GPS e orientação por bússola de forma offline. Ele é gratuito para 

elaboração de até 3 mapas e possui integração com o QGIS, que possibilita a montagem 

de mapa, com informações de pontos e polígonos e exportar para o aplicativo AVENZA um 

arquivo PDF georreferenciado para edição em campo de polígonos e pontos. Este aplicativo 

possui os mesmos recursos que o QFIELD, porém possui interface mais intuitiva.

•	 GPS LOGGER: Ferramenta prática e acessível para coleta de dados geoespaciais em campo, 

ideal para mapear trajetos, pontos de interesse e áreas específicas. Esse aplicativo registra 

continuamente as coordenadas geográficas com base na posição do usuário, permitindo 

a criação de mapas detalhados ou a integração dos dados coletados em softwares de 

geoprocessamento. O GPS Logger se destaca pela simplicidade de uso e portabilidade, sendo 

uma solução econômica e eficiente para profissionais de campo.

•	 FIELD MAPS: Aplicativo da ESRI que permite a coleta de dados geoespaciais em campo, 

visualização de mapas offline, edição de dados e navegação. Ele integra-se com sistemas 

como ArcGIS Online, facilitando a sincronização e o uso de dados em tempo real. Suas funções 

incluem registrar informações diretamente no mapa, rastrear equipes em campo e utilizar 

mapas em áreas sem internet.

•	 C7 GPS DADOS: Aplicativo para celular ou tablet para obtenção de coordenadas de pontos 

isolados (waypoints) ou de trilhas. Com os dados armazenados em arquivo podem ser 

processados cálculos de área e perímetro de polígonos e da distância total percorrida em 

uma trilha registrada.

•	 TIMESTAMP CAMERA: Aplicativo para dispositivos móveis ideal para capturar fotos com 

informações registradas diretamente na imagem, como data, hora, nome do projeto, identificação 

da propriedade e outras anotações personalizáveis. Essa funcionalidade é especialmente útil para 

documentar características relevantes do campo, assegurando a autenticidade e organização 

das imagens que serão incluídas em relatórios ou arquivadas como parte do acervo do projeto. 

Além de facilitar o registro visual das condições iniciais e das intervenções realizadas, o aplicativo 

contribui para a padronização e a rastreabilidade das informações.

Ressalta-se que os exemplos apresentados são apenas algumas das opções recomendadas, com 

o objetivo de proporcionar flexibilidade para que diferentes iniciativas possam adaptar suas operações 

conforme os recursos disponíveis. Vale destacar que existem diversas alternativas de equipamentos, 

softwares e aplicativos que podem ser utilizados, desde que atendam de forma eficiente às demandas 

específicas de cada tarefa.

Base de Dados Geográficos

A utilização de bases de dados geográficos também desempenha um papel essencial, tanto na 

elaboração do PIP quanto para gestão do projeto. Esses dados não apenas facilitam o planejamento das 

intervenções, mas também são fundamentais para o monitoramento e a avaliação contínua das áreas. A 

integração dessas informações geoespaciais possibilita que as ações no PIP sejam estabelecidas de forma 

eficiente, considerando as especificidades de cada propriedade e sua relação com o ambiente.
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Os principais elementos de base de dados foram apresentados abaixo.

Uso e Ocupação do Solo

Um dos principais componentes da base de dados geográficos, necessário para a identificação 

e distribuição das diferentes características da propriedade como áreas agrícolas, pastagens, 

vegetação nativa, entre outras. Essa camada temática na base de dados orienta a tomada de 

decisões sobre quais práticas e intervenções podem ser adotadas.

Rede Hidrográfica

Outro elemento essencial, a camada de hidrografia apresenta as nascentes, rios e outros 

corpos hídricos na propriedade e na região do projeto. Permite uma análise detalhada da 

disponibilidade de recursos hídricos e da influência das práticas agrícolas sobre eles. Permite 

identificar a localização exata das nascentes e cursos d’água para delimitação das APPs, além 

de planejar e monitorar práticas conservacionistas, como cercamento de nascentes e manejo 

sustentável de áreas ripárias.

Imagens de satélite e/ou fotografia aérea

Permitem identificar mudanças na cobertura do solo, como degradação de pastagens ou 

expansão de áreas agrícolas, e monitorar a evolução das áreas reflorestadas. A possibilidade 

de obter imagens atualizadas em alta resolução facilita o diagnóstico de áreas críticas, 

auxiliando na identificação de áreas com maior necessidade de intervenção, bem como no 

acompanhamento dos resultados das ações implementadas. A inclusão dessas imagens nas 

bases de dados permite um registro histórico da evolução das propriedades, tornando as 

análises mais robustas e embasadas.

Modelos Digitais de Terreno (MDT)

Fundamentais para entender a topografia e identificar áreas de maior risco de erosão. Esses 

modelos facilitam o planejamento das intervenções e ações voltadas para a conservação do 

solo e da água, como a construção de barraginhas, curvas de nível e terraceamentos, além de 

permitir a delimitação de APP de declividade e de topos de morros.

De modo geral, as bases de dados geográficas dos projetos Produtor de Água são estruturadas a partir 

dos produtos obtidos no diagnóstico ambiental da bacia hidrográfica, adequadas para análises em escala 

regional. A precisão destes dados permite orientar bem as decisões em larga escala, mas pode não ser 

suficientemente detalhada para análises específicas para o planejamento detalhado das propriedades rurais.

Sites e plataformas para download de dados geográficos gratuitos

•	 Mapeamento em alta resolução dos biomas brasileiros da FBDS

Base cartográfica disponibilizada pela Fundação Brasileira para o Desenvolvimento Sustentável 

(FBDS). Apresenta dados vetoriais em alta resolução (escala 1:25.000), no formato shapefile (SHP), por 

UF e município, no período de 01/01/2013 a 30/04/2023. Mapeamento composto por três categorias de 

informação:  Uso e cobertura do solo; Hidrografia; Áreas de preservação permanente ripárias. 

Link de acesso: https://geo.fbds.org.br/

https://geo.fbds.org.br/
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•	 MapBiomas 10 metros

Esta coleção BETA do MapBiomas inclui mapas anuais de cobertura e uso da terra de todo o Brasil 

para o período de 2016 a 2022, classificados a partir de imagens do satélite Sentinel-2 com resolução 

espacial de 10 metros. Os mapas podem ser baixados em formato GeoTiff (um arquivo por ano).

Link de acesso: https://brasil.mapbiomas.org/mapbiomas-cobertura-10m/

•	 Agência Nacional de Águas e Saneamento Básico - ANA

Conjunto de dados geográficos abertos sobre corpos hídricos para todo território brasileiro, como 

divisão das bacias hidrográficas e base hidrográfica ottocodificada, em diferentes níveis de detalhamento.

Link de acesso: https://dadosabertos.ana.gov.br/search?groupIds=084346aa5c18467782432f48bb687f83

•	 ANADEM – Instituto de Pesquisas Hidráulicas (IPH) da Universidade Federal do Rio Grande do 

Sul (UFRGS) e ANA

Modelo digital de terreno com remoção de viés causado pela vegetação no Modelo Digital de 

Elevação (MDE) Copernicus GLO-30, com resolução espacial de 30 metros, e disponível para toda a 

América do Sul.  

Link de acesso: https://metadados.snirh.gov.br/geonetwork/srv/api/records/93664c15-1ff8-4e87-

bbed-2bb69d321309

•	 Planet Basemaps

Imagem com 5 metros de resolução com disponibilidade de mosaico mensal a partir do ano de 2015.

Link de acesso: https://university.planet.com/introduction-to-planet-basemaps-pt-br

•	 Imagem Sentinel 

Imagem de satélite com resolução de 10 metros e Modelo Digital de Elevação (12 metros). 

Link de acesso: https://apps.sentinel-hub.com/eo-browser/

•	 Imagens CBERS - Instituto Nacional de Pesquisas Espaciais (INPE)

Imagens em alta resolução do satélite CBERS-4, disponíveis a partir de maio de 2022.

Link de acesso para os procedimentos de download: https://www.gov.br/pt-br/servicos/obter-

imagens-de-sensoriamento-remoto-da-terra-geradas-pelo-satelite-cbers-04a

Portais úteis para apoio na elaboração do PIP

•	 Plataforma SICAR

O SiCAR disponibiliza dados públicos do CAR por meio de ferramentas de consulta online. Algumas 

informações agregadas são públicas e podem ser baixadas, como limites de áreas cadastradas e situação 

ambiental. O detalhamento de áreas e informações pessoais são protegidos por leis como a Lei Geral de 

Proteção de Dados (LGPD).

Link de acesso: https://www.car.gov.br/

•	 Portal Conservador da Mata Atlântica

Plataforma desenvolvida pela The Nature Conservancy (TNC) que reúne dados territoriais, como 

hidrografia, APP, imagens de satélite e informações do CAR. Entre outras funções de análises espaciais, 

permite delimitar manualmente ou fazer upload dos limites da propriedade e exportar as informações em 

formatos SHP, KML ou PDF georreferenciado.

Link de acesso: https://portaldamantiqueira.org.br/mapa/

https://brasil.mapbiomas.org/mapbiomas-cobertura-10m/
https://dadosabertos.ana.gov.br/search?groupIds=084346aa5c18467782432f48bb687f83
https://metadados.snirh.gov.br/geonetwork/srv/api/records/93664c15-1ff8-4e87-bbed-2bb69d321309
https://metadados.snirh.gov.br/geonetwork/srv/api/records/93664c15-1ff8-4e87-bbed-2bb69d321309
https://university.planet.com/introduction-to-planet-basemaps-pt-br
https://apps.sentinel-hub.com/eo-browser/
https://www.gov.br/pt-br/servicos/obter-imagens-de-sensoriamento-remoto-da-terra-geradas-pelo-satelite-cbers-04a
https://www.gov.br/pt-br/servicos/obter-imagens-de-sensoriamento-remoto-da-terra-geradas-pelo-satelite-cbers-04a
https://www.car.gov.br/
https://portaldamantiqueira.org.br/mapa/
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Para elaboração do PIP, que demanda dados mais precisos, essa base geral serve como ponto de 

partida nas etapas de geoprocessamento, devendo ser ajustada e refinada com base nas análises prévias 

e coleta de dados em campo, possibilitando a criação de uma base individualizada para cada propriedade.

Em alguns casos, projetos contratam produtos cartográficos de maior resolução e em escala grande 

de mapeamento para melhorar a precisão das análises em nível de propriedade. No entanto, os altos custos 

envolvidos podem ser um fator limitante em muitas situações. Como alternativa, diversas plataformas 

institucionais disponibilizam gratuitamente dados geográficos em escala nacional, que podem ser usados 

para complementar e enriquecer as informações dos projetos sem custos adicionais, exemplificados abaixo.
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4	 ELABORANDO O PIP
Esta seção do manual tem um enfoque prático, detalhando de forma clara e objetiva as etapas e 

procedimentos necessários para a elaboração do PIP. O processo é orientado por diretrizes específicas, 

que podem variar conforme a estrutura do projeto e, principalmente, as características conceituais e 

metodológicas ajustadas à realidade local. O objetivo é oferecer um guia completo das etapas essenciais, 

garantindo ao mesmo tempo a flexibilidade necessária para adaptações ao contexto e às particularidades 

de cada iniciativa.

Este manual não tem a intenção de impor um padrão rígido quanto aos 

procedimentos de elaboração do PIP. Cada projeto deve adaptar as etapas e os 

procedimentos conforme os recursos físicos, humanos e tecnológicos disponíveis. 

O importante é entender o propósito e a função de cada etapa, reconhecendo que 

diferentes abordagens podem ser adotadas para alcançar resultados semelhantes.

A elaboração do PIP envolve, essencialmente, realizar o diagnóstico da propriedade para propor uma 

nova forma de distribuição de uso do solo, alinhada aos objetivos do projeto, por meio de um plano de ação 

que otimize os recursos disponíveis (Figura 4).

Como já mencionado, o processo de elaboração do PIP é dividido em dois momentos distintos e 

complementares.

Inicialmente é elaborado o PIP Ideal, considerando a máxima adequação hidroambiental da 

propriedade, que é apresentado ao proprietário ou produtor rural com as propostas de intervenções a serem 

realizadas em sua propriedade, podendo ser aceito total ou parcialmente. Após negociação, é elaborado o 

PIP Pactuado que deve refletir o acordo entre as partes sobre as intervenções a serem implementadas. 

O PIP Ideal apresenta as propostas de possibilidades de adequação e, após a negociação, é ajustado 

e complementado para se tornar o PIP Pactuado, com informações detalhadas de um projeto técnico 

executivo que servem de base para o cálculo dos valores de PSA, elaboração de contratos, implementação 

de práticas conservacionistas e monitoramento dos serviços ambientais prestados.

Para entendimento do fluxo de trabalho completo, a figura abaixo fornece uma visão geral de todas 

as etapas envolvidas na elaboração do PIP e fornece uma referência rápida e clara sobre os processos, 

facilitando a navegação no manual e o entendimento do escopo das atividades.

Após o processo de elaboração do PIP, segue-se com as demais etapas de implementação do 

projeto Produtor de Água, relativas à: confecção e assinatura do contrato; implementação das práticas 

conservacionistas; vistorias de monitoramento e, Pagamentos pelos Serviços Ambientais aos beneficiários.



Série Manuais do Programa Produtor de Água: Vol.3 Elaboração de Projeto Individual de Propriedade

44

Figura 4 - Fluxograma com as etapas de elaboração do PIP
Fonte: Renato Atanazio

Conforme já mencionado, o Programa Produtor de Água oferece um arcabouço 

metodológico para orientar o desenvolvimento e a execução dos projetos locais, que 

exige adaptação de diversos fatores ao contexto de cada região. 

Considerando que a elaboração do PIP exige que esses ajustes e configurações 

locais estejam bem definidos, os procedimentos apresentados consideraram as seguintes 

predefinições, para apresentação de exemplos práticos com fins ilustrativos.

•	 Modelo de PIP: Apresenta um conteúdo mínimo, elaborado com base na análise 

de diversos projetos Produtor de Água, que pode ser incrementado ou ajustado 

conforme as necessidades de cada caso;

•	 Metodologia de valoração: Necessária para orientar os cálculos dos valores de 

PSA e conteúdo dos mapas. A metodologia proposta segue as recomendações 

do Programa Produtor de Água e inclui três modalidades de valoração; e,

•	 Geoprocessamento de dados e elaboração dos mapas: Considera o uso dos 

softwares de geoprocessamento ArcGIS e QGIS, sendo os mais amplamente 

utilizados nos projetos.
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A estrutura completa do PIP com detalhes sobre o preenchimento do PIP Ideal e do PIP Pactuado, está 

descrita no tópico 4.4 deste manual.

4.1	 Etapa 1 – Caracterização e diagnóstico da propriedade

Uma vez que os proprietários estejam mobilizados, informados sobre o projeto e tenham formalizado 

sua adesão com a documentação exigida, os técnicos responsáveis pela elaboração do PIP entram em 

contato com o responsável pela propriedade para solicitar informações para iniciar a caracterização e 

diagnóstico da propriedade.

Embora possa ser realizado de diversas formas, este manual propõe que a caracterização e diagnóstico 

sejam realizados em dois momentos:

I.	 Diagnóstico inicial: Consiste no trabalho interno de escritório com a coleta e reunião de 

informações preliminares para entendimento do contexto da propriedade e identificação das 

principais características; e,

II.	 Visita de vistoria inicial: para confirmação das informações coletadas previamente e obtenção 

de novos dados a partir da verificação em campo e conversas com o proprietário/produtor.

As informações coletadas durante o diagnóstico devem ser integradas ao PIP, contribuindo para a 

redação dos descritivos, preenchimento de tabelas e quadros, elaboração de mapas e para os cálculos do PSA.

As informações específicas sobre a situação da propriedade quanto à necessidade 

de recomposição de APP, podem ser verificadas previamente no momento de diagnóstico 

inicial da propriedade, a partir da análise das informações do CAR, bem como de outros 

sistemas estaduais complementares.

Imagens históricas disponíveis no Google Earth podem ser utilizadas para 

verificação das áreas consolidadas, selecionando imagens anteriores a julho de 2008.

Para garantir eficiência no processo de coleta de informações, recomenda-se a utilização de um roteiro 

de perguntas pré-definido que cubra todos os dados necessários ao PIP. Esse roteiro deve ser ajustado às 

especificidades de cada projeto.

4.1.1	 Diagnóstico inicial da propriedade

A coleta de informações iniciais da propriedade é essencial para identificar de forma preliminar quais 

são as características da propriedade quanto aos usos, principais atividades, cursos d’água, áreas adequadas 

para conservação, restauração, legislação aplicável, entre outros. 

Para tanto, são solicitados ao proprietário documentos que ajudem a definir as delimitações legais da 

propriedade, como escrituras, certidões de registro de imóveis, mapas ou croquis recentes e antigos, entre 

outros. Esses documentos são essenciais para a elaboração de um mapa preliminar da propriedade, que 

orientará a visita técnica.

Busca-se, também, informações sobre as exigências legais que se aplicam à propriedade, especialmente 

a partir dos dados do CAR. Verificar a existência de sistemas locais e estaduais complementares ao CAR, como 

o CEFIR (BA), o SICAR (SP), o SICAR (PR), o SIMCAR (MT), entre outros sistemas que geram recomendações 

e orientações relacionadas à adequação ambiental da propriedade, à conformidade com a legislação e à 

necessidade de ações de regularização. Isso ajudará na identificação de áreas adequadas para o projeto, 

como conservação e restauração, e na detecção de possíveis conflitos de área.
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Embora haja muitos recursos tecnológicos disponíveis que permitem a realização 

de um diagnóstico muito preciso apenas com trabalhos em escritório, o PIP não pode 

ser realizado sem a ida a campo para confirmação das informações e, principalmente, 

para que o proprietário participe ativamente desde o início dos trabalhos.

A quantidade e qualidade das informações coletadas no diagnóstico inicial dependem muito 

da estrutura técnica disponível para o projeto, especialmente quanto aos elementos da base de dados 

geográficos disponível adquirida ou elaborada pelo projeto na fase de diagnóstico da bacia. A depender das 

informações do diagnóstico da bacia, muitas das perguntas para caracterização da propriedade já poderão 

ser respondidas antes da visita de campo.

4.1.2	 Elaboração do mapa ou croqui preliminar da propriedade

A partir das informações iniciais, e com o suporte de uma base de dados geográficos utilizando 

software de geoprocessamento, é possível a formulação de um mapa ou croqui para ser utilizado como 

ferramenta de campo na visita de vistoria inicial, para garantir que os técnicos cheguem às propriedades 

com informações prévias, otimizando o tempo e aumentando a precisão das verificações. Recomenda-se 

que o mapa contenha as seguintes informações: 

•	 Poligonal dos limites da propriedade: pode ser delimitado com base nos documentos e 

mapas apresentados, dados do CAR ou utilizar malha fundiária, caso o projeto disponha;

•	 Ponto e coordenadas da sede e da entrada da propriedade: importante para orientar 

como chegar na propriedade. Pode ser fornecido pelo proprietário ou coletado a partir da 

identificação na imagem de satélite;

•	 Hidrografia: caso o projeto não disponha de uma base em escala compatível com a 

propriedade, os cursos de rios e pontos de nascentes poderão ser criados manualmente, 

identificados em imagens de satélite, como por exemplo imagens do Google Earth: e,

•	 Imagem de satélite ou ortomosaicos: Utilizar base de imagens mais atualizada possível. Caso 

o projeto não disponha de base de imagens de qualidade e atualizada, poderá ser utilizada a 

imagem mais recente do Google Earth para conferência do limite, baseando-se nas estradas, 

cursos d’águas, entre outros. Há também a possibilidade de acesso a imagens de satélite de 

diversas fontes, a partir do plugin “QuickMapServices” do software QGIS.
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Figura 5 - Exemplo de croqui preliminar de propriedade rural
Fonte: Organização de Conservação da Terra [OCT] (2024)

Dependendo da qualidade, resolução e atualização da imagem de satélite ou da disponibilidade de 

uma base de dados de uso do solo em escala compatível com a propriedade, é possível também delimitar 

previamente os polígonos das glebas dos diferentes usos da propriedade para compor o mapa e posterior 

confirmação em campo.

Vale ressaltar que os limites definidos neste mapa não necessariamente estarão corretos e precisos, 

pois servem apenas de apoio para nortear os técnicos durante a visita a campo. 

Para facilitar a identificação das características da propriedade em campo, as informações de limites da 

propriedade, estradas e cursos de rios podem já receber ajustes manuais, baseadas na imagem de satélite, 

para que as camadas temáticas do mapa estejam minimamente alinhadas à imagem.

O mapa pode ser impresso em papel ou ser exportado em meio digital. A exportação pode ser feita 

pelos softwares ArcGIS ou QGIS um layout em formato PDF georreferenciado, que pode ser lido por outros 

softwares de mapeamento, que reconhecem a localização espacial dos elementos dentro do mapa, como 

por exemplo os aplicativos para smartphone ou tablet AVENZA MAPS e QFIELD. Estes softwares permitem 

a visualização e edição do mapa em campo para posterior importação e geoprocessamento dos dados 

coletados em campo.

Dica: O Portal Conservador da Mata Atlântica pode ser acessado e utilizado para 

formulação deste mapa em algumas regiões do país, em especial nos estados de SP, RJ 

e BA. O Portal contém uma base de dados com camadas de uso do solo, hidrografia, 

imagens de satélite, entre outros, e permite a delimitação manual – ou upload – dos 

limites da propriedade para posterior exportação das informações em formatos SHP ou 

KML ou exportação do layout em PDF georreferenciado. 

Link de acesso: https://portaldamantiqueira.org.br/login/

https://portaldamantiqueira.org.br/login/
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4.1.3	 Visita técnica de vistoria inicial da propriedade

Realizado o diagnóstico inicial, a visita de vistoria inicial pode ser realizada. Com data e horário 

agendado, a equipe técnica responsável pela elaboração do PIP se apresenta na propriedade para conversa 

com o produtor e conhecimento da área.

Equipamentos considerados nestes procedimentos:

•	 Dispositivo GPS, podendo ser geodésico, de navegação ou App em aparelho 

celular;

•	 Máquina fotográfica, podendo ser de aparelho celular;

•	 Mapa preliminar (croqui) impresso ou digital acessado em dispositivo móvel; 

•	 Caderneta de anotações ou aplicativo de anotações para dispositivos móveis; 

•	 Veículo apropriado para deslocamento em áreas rurais;

•	 Lembrando que, conforme disponibilidade de cada projeto, outros equipamentos 

podem ser utilizados para levantamento de informações mais precisas, como 

por exemplo, drones.

A visita consiste em:

•	 Conhecer toda a propriedade baseado na conversa com o proprietário e verificação visual;

•	 Conferir e coletar pontos dos limites da propriedade e de outras informações de interesse;

•	 Identificar aspectos ambientais e situação das áreas de vegetação nativa e dos corpos hídricos;

•	 Identificar áreas agrícolas e pastagens, bem como tipos de manejos utilizados e processos 

erosivos; e,

•	 Registrar por meio de fotos as diversas peculiaridades e paisagens da propriedade.

Inicialmente ocorre uma conversa entre os técnicos e o proprietário para apresentar o projeto, 

esclarecer dúvidas e informar o objetivo da visita.

O primeiro passo é verificar com o produtor quais os limites da propriedade, identificar corpos d’água 

e nascentes e a localização das áreas de uso na propriedade e nas áreas adjacentes. 

A abordagem do/a técnico/a deve ser respeitosa, transmitir segurança e confiança 

ao proprietário e/ou responsável, deixando claro que a atividade realizada tratará com a 

devida atenção as informações passadas e serão de uso exclusivo ao desenvolvimento 

dos Projetos, estando de acordo com a Lei Geral de Proteção de Dados Pessoais [LGPD] 

(Lei nº 13.709/2018).

Conferência das informações prévias e coleta de pontos de interesse 

Caminhando pela propriedade são tomadas as coordenadas geográficas dos pontos de interesse 

utilizando-se o dispositivo GNSS. Na medida do possível, para garantir maior precisão, recomenda-

se percorrer todo o limite da propriedade e coletar pontos dos vértices da poligonal como um todo, 

considerando que grandes áreas poderão exigir mais de uma visita.
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A coleta de pontos pode ser feita utilizando pontos de referência na propriedade que possam ser 

identificados na imagem de satélite do croqui em mãos (como árvores, casas, estradas, rios, diferença de 

tonalidade entre as culturas, entre outros). 

Lembre-se de nomear e/ou numerar os pontos coletados diretamente no 

dispositivo GPS e anotar o número dos pontos e quais suas características para facilitar 

a organização e processamento dos dados posteriormente.

A partir de pontos de referência, coletar pontos dos limites e vértices entre os usos para ajudar no 

processamento dos dados e delimitação das glebas posteriormente.

Recomenda-se, inclusive, fazer ajustes e marcações diretamente no mapa de campo para as 

delimitações da propriedade, dos usos, das APP, RL, nascentes e rios.

Deve-se coletar o maior número de pontos possível nos rios para posterior ajuste da base hidrográfica 

e buscar saber o nome dos rios que passam pela propriedade, bem como dos seus afluentes e do rio 

principal da bacia para identificação e posterior confirmação da bacia hidrográfica. 

Caracterização das áreas de produção, tipos de usos e formas de manejo

Identificar e registrar informações sobre:

•	 Principal uso atual da propriedade (lazer, produção agrícola, moradia etc.);

•	 Tipos de atividades produtivas com indicativo dos cultivos e formas de manejo do solo;

•	 Ocorrência de algum fator de limitação ou potenciais problemas relacionados à conservação 

do solo, como indicação de processos erosivos e pontos de assoreamento nos corpos hídricos;

•	 Se há rebanho e quais suas características;

•	 Situação das estradas internas ou mesmo que não faça parte da propriedade, mas que seja de 

uso direto do produtor. Neste caso a estrada não entra no PIP, mas pode ser registrada e levada 

para reunião para receber intervenção futura pelo projeto; e,

•	 Existência de práticas conservacionistas adotadas previamente ao projeto, como cercas 

e aceiros para proteção da vegetação nativa, estruturas de condução e captação de águas 

pluviais em estradas internas como valetas, lombadas, caixas secas e barraginhas, entre outros.

Foto 9  – Visita de vistoria em propriedade rural de projeto Produtor de Água. Áreas de uso agrícola (SC)
André Targa Cavassani / Banco de imagens ANA
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Dependendo das definições gerais do projeto, podem ser necessárias coletas de amostras de solo para 

análise em laboratório, além de avaliação da qualidade da água superficial e dos ecossistemas aquáticos, 

nos pontos de coleta de amostras de água. 

Caracterização dos recursos hídricos e sistemas de saneamento rural

Identificar e registrar informações sobre:

•	 Quantidade de nascentes, rios e veredas, se intermitentes ou perenes;

•	 Situação da calha dos cursos d’água, se há erosão da borda e/ou assoreamento;

•	 Importante buscar entender em que frequência ocorrem eventos de chuva intensas e qual o 

comportamento da água na propriedade;

•	 Dessedentação de animais, se direto no curso do rio ou existência de bebedouros;

•	 Se há abastecimento doméstico e qual o tipo (poços, captação em nascentes, abastecimento 

público);

•	 Forma de captação de água (direto na nascente sem proteção, caxambu etc.); 

•	 Se há irrigação, para quais atividades e localização do ponto de captação;

•	 Se há reservatórios, lagos ou açudes, e para quais usos;

•	 Esgotamento sanitário (fossa séptica, fossas secas, alagados construídos etc.); 

•	 Gestão e destinação de resíduos sólidos (compostagem, aterros controlados, coleta seletiva, 

queima etc.); e,

•	 Se há aplicação de Ato Declaratório ou Outorga.

Caracterização dos aspectos ambientais

Identificar e registrar informações sobre:

•	 Caracterização dos fragmentos com vegetação nativa (fitofisionomia e grau de proteção);

•	 Presença de espécies exóticas;

•	 Situação das APP e necessidades de recomposição para adequação legal; 

•	 APP ocupadas por pastagem com cercamento; 

•	 Presença de aceiros e histórico de incêndios;

•	 Nascentes fora da propriedade localizadas a menos de 50m de distância do limite da 

propriedade; e,

•	 Se há e qual a situação de vegetação nativa remanescente excedente a APP e RL.



51

Série Manuais do Programa Produtor de Água: Vol.3 Elaboração de Projeto Individual de Propriedade

Foto 10 – Visita de vistoria em propriedade rural de projeto Produtor de Água. Áreas destinadas à restauração (SC)
André Targa Cavassani / Banco de imagens ANA

Verificar com o produtor se a RL está regularizada, a sua localização e a caracterização do seu uso e 

da ocupação do solo. Na verificação de RL, confirmar com o produtor qual a área informada no CAR. Caso 

o técnico identifique que há ganho ambiental em mudar a RL, é possível propor uma nova delimitação ao 

produtor. Caso ele aceite, o CAR deve ser retificado. 

Registro fotográfico das diversas peculiaridades e paisagens da propriedade

Fazer registro fotográfico de todos os pontos relevantes da propriedade. Recomenda-se fazer fotos na 

horizontal para facilitar layout do PIP e dos relatórios. Além disso, para facilitar a organização, sugere-se o 

de software específicos sugeridos neste material, como o “Timestamp Camera”, que permite incluir registro 

de data, hora, coordenadas geográficas, nome da propriedade, nome do projeto e característica da área. 

Fotografar as principais características da propriedade, especialmente:

•	 Entrada da propriedade;

•	 Áreas produtivas das principais atividades;

•	 Áreas com solo exposto, degradadas e/ou com processos erosivos;

•	 Situação das estradas internas;

•	 Infraestrutura de saneamento e outros pontos que tenham interesse especial;

•	 Áreas com necessidade e/ou potencial de conservação ou restauração; e,

•	 Áreas onde serão realizadas intervenções, como cercamento, restauração via plantio, aceiros 

e estruturas de condução e captação de águas pluviais em estradas internas como valetas, 

lombadas, caixas secas e barraginhas, entre outros.  

Lembrando que nem todas as fotos serão documentadas no PIP, mas todo o acervo fotográfico 

referente àquela propriedade deve ser arquivado para organização e futuras ações de verificação e/ou 

monitoramento.
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As orientações apresentadas neste tópico são exemplos de informações a serem 

verificadas em campo, que condizem às definições criadas para este manual. Um 

checklist pode ser elaborado como um roteiro de perguntas a ser feita ao proprietário 

para que nada fique de fora. Muitas informações já podem estar respondidas baseadas 

no diagnóstico inicial e devem ser confirmadas na conversa e na verificação visual.

4.2	 Etapa 2 – Geoprocessamento e elaboração dos mapas

Após caracterização da propriedade e levantamento das informações durante a visita técnica, segue-

se para o processamento dos dados em escritório com uso de softwares de geoprocessamento. Os objetivos 

desta etapa serão a preparação e ajustes de dados e a formulação dos mapas do PIP.

A preparação e ajustes dos dados (transferência, conversão e criação de arquivos) para criação 

de base de dados da propriedade que considera as seguintes camadas de informações:

•	 Limite da propriedade;

•	 Uso e ocupação do solo;

•	 Hidrografia;

•	 Áreas de Preservação Permanente;

•	 Uso do solo com situação das APP;

•	 Modalidades de PSA.

A formulação dos mapas do PIP, sendo:

•	 Mapa de localização da propriedade na bacia / área do Projeto; 

•	 Mapa de uso e ocupação do solo da propriedade;

•	 Mapa dos serviços ambientais ou das modalidades de PSA; e  

•	 Mapas individualizados das glebas.

Os procedimentos aqui apresentados consideram o uso de versões recentes dos 

softwares multiplataforma de sistema de informação geográfica ArcGIS e QGIS para 

visualização, análise e processamento de dados georreferenciados.

4.2.1	 Preparação e ajustes dos dados

Transferência e conversão de arquivos e inserção na base de dados geográficos

A primeira etapa no processamento de dados é a transferência dos arquivos de GNSS levantados em 

campo. Dependendo do dispositivo e aplicativo utilizado, os arquivos dos dados (pontos linhas e polígonos) 

coletados em campo poderão estar em diferentes formatos e extensões, tais como SHP, KML, DXF, DWG, 

entre outros. Para transferência, utilizar o software do dispositivo e/ou da aplicação utilizada para coleta e 

carregá-los na base de dados do projeto.
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Figura 6 - Exemplo de croqui com pontos coletados em visita de vistoria
Fonte: OCT (2024)

Converter todos os arquivos em extensão trabalhada pelos softwares utilizado e conforme base de 

dados do projeto, sendo recomendada a conversão em formato Geopackage, atualmente muito utilizado 

pelo QGIS, ou no formato Shape File utilizado pelos softwares ArcGIS e QGIS.

4.2.2	 Criação das camadas de informações (layers)

Limite da propriedade - ajuste da poligonal

Esta camada de informação contribui para a formulação de todos os mapas considerando que o limite 

da propriedade é apresentado em todos eles, além de ser o primeiro ajuste necessário que orientará os 

ajustes das demais informações geográficas.

Baseado nos pontos coletados, que devem estar identificados com numeração e anotações feitas 

em campo, e nas informações da base de dados geográficos (imagem de satélite, hidrografia, malha viária, 

malha fundiária etc.), efetuar ajuste do limite/poligonal da propriedade.

Se o projeto dispuser de uma base de dados fundiária com boa precisão e escala de mapeamento 

compatível com a propriedade, esta pode ser utilizada como referência para georreferenciamento.

Caso a propriedade possua georreferenciamento conforme as normas do Incra– 

ou, em alguns casos, se existir o CAR homologado, feito com apoio de técnicos da 

extensão rural - entende-se que a poligonal estará bem precisa, podendo servir como 

principal referência para ajuste desta informação.

É comum haver diferença entre a área da poligonal mapeada e a área informada 

pelo proprietário ou produtor no momento da inscrição no projeto. Em muitos casos, 

considera-se uma margem de erro entre o valor informado e o mapeado, tratando a 

área como «estimada». É importante conhecer como essa regra foi definida no projeto 

para orientar corretamente o proprietário. Casos mais complexos, em que a discrepância 

excede significativamente a margem de erro, podem ser levados para discussão em 

reuniões e assembleias da UGP.

O ajuste pode ser feito de forma manual criando e arrastando o polígono, movendo e excluindo 

vértices. Após ajustada, a poligonal da propriedade estará georreferenciada de forma definitiva e servirá de 

referência para a delimitação dos demais polígonos como APP e glebas de uso do solo e das modalidades.
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Camada de Uso e Ocupação do Solo

Esta ação tem como objetivo criar a camada de uso e ocupação do solo da propriedade a partir da 

delimitação das áreas dos diferentes tipos de uso. Estas informações comporão a base de dados de uso e 

ocupação do solo da propriedade, que será uma das camadas (layers) utilizadas diretamente no mapa de 

uso do solo, além de ser referência para criação da camada de modalidades de PSA para utilização no mapa 

deste mesmo nome.

Procedimentos

I.	 Criar ou importar arquivo vetorial de polígono e iniciar a delimitação dos polígonos das glebas, 

baseado nos pontos coletados em campo que delimitam os diferentes usos da propriedade, 

e que devem estar identificados com numeração e anotações das características feitas em 

campo.

•	 No ArcGIS, vá em “Catalog” e crie um shapefile (polígono), definindo o sistema de 

coordenadas correto. Ative o modo de edição e desenhe manualmente os polígonos de 

cada tipo de uso do solo com base na imagem de fundo (satélite ou ortofoto) e baseado 

nos pontos coletados em campo.

•	 No QGIS: Em “Camada” > “Criar Camada” > “Nova Camada Shapefile”, crie um shapefile para 

uso do solo. Defina os atributos (ex.: Tipo, Categoria). Ative o modo de edição e desenhe 

manualmente os polígonos.

II.	 Certificar-se que os limites das glebas delimitadas estão claros, sem sobreposições e que 

representam as realidades da área verificada em campo. Pode ser necessário novos ajustes 

manuais na delimitação ou utilize ferramentais de edição:

•	 ArcGIS: “Editor”, “Cut Polygon” e “Merge” para ajustar e corrigir os polígonos.

•	 QGIS: No “Modo de Edição”, use as ferramentas como cortar, mesclar, dividir. 

Use também ferramentas de correção topológica para garantir a precisão do mapeamento:

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.

III.	 Na tabela de atributos, adicione campos para informações como “Classe uso do solo” e “Área 

(ha)”. Alimente estes campos manualmente conforme as classes de uso e utilize a função 

“Field Calculator” para calcular áreas, se necessário.

IV.	 Salve ou exporte a camada resultante como um arquivo vetorial shapefile (ou outros conforme 

software utilizado) e nomeie como “Usodosolo_propriedade_xx”.
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Figura 7 - Representação gráfica dos passos para criação da camada de uso do solo
1 - Pontos coletados em campo (imagem à esquerda); 2 - Delimitação das glebas (imagem do meio); 3 - Glebas de uso do solo 

definidas (imagem à direita).

Fonte: OCT (2024).

As classes de uso e ocupação do solo devem ser previamente estabelecidas 

para o projeto conforme resultados obtidos no diagnóstico da bacia, baseados nas 

características preponderantes na região. Caso o projeto não disponha desta base, 

poderão ser utilizadas como referência as classes indicadas neste manual, baseado em 

IBGE (2013). Lembrando que estas são genéricas e devem ser adequadas conforme 

contexto local. São elas:

•	 Culturas temporárias (grãos, legumes e hortaliças etc.);

•	 Culturas perenes (frutíferas, café, cana, vinhedos etc.);

•	 Silvicultura;

•	 Pastagem;

•	 Solo exposto ou áreas degradadas;

•	 Espelho d’água;

•	 Benfeitorias;

•	 Estradas internas;

•	 Vegetação nativa em bom estado de conservação (primária ou em estágio 

médio/avançado de regeneração);

•	 Vegetação nativa em estágio inicial de regeneração;

•	 APPs; e,

•	 RLs

Hidrografia

Esta ação tem como objetivo criar as camadas que representam as características dos corpos hídricos 

da propriedade, que serão utilizados em todos os mapas previstos no PIP, além de servirem como como 

base para delimitação das APP.

Considera-se aqui a criação das camadas de:
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•	 Linhas dos rios e cursos d’água;

•	 Pontos das nascentes e olhos d’água; e,

•	 Polígonos de rios maiores de 10m de largura, lagos e lagoas naturais e reservatórios artificiais.

Procedimentos:

I.	 Utilize uma camada vetorial de rios e cursos d’água existente ou extraia a rede hidrográfica 

de um Modelo Digital de Terreno (MDT) usando ferramentas como “Hydrology” no ArcGIS ou 

“r.watershed” no QGIS/GRASS.

Certifique-se de que os cursos d’água estão corretamente representados, de preferência com 

base em dados confiáveis, como mapeamentos hidrológicos oficiais.

II.	 Dependendo da escala de mapeamento da malha hidrográfica disponível, recomenda-

se ajustar de forma manual a linha do curso do rio, já que os pontos coletados em campo 

apresentam, teoricamente, uma precisão maior do que a base. Neste caso, a malha hidrográfica 

da base de dados do projeto pode receber ajustes com base na linha do curso do rio então 

delimitado de forma individualizada para a propriedade.

III.	 Na tabela de atributos, adicione informações “Nome Rio” (texto) e alimente este campo 

manualmente, conforme disponibilidade de informações.

IV.	 Salve ou exporte a camada resultante como um arquivo vetorial e nomeie como “rios_

propriedade”.

Para outros corpos hídricos, realizar os mesmos procedimentos, considerando a 

criação de arquivo vetorial de:

•	 Pontos para nascentes (considerar nascentes presentes na propriedade e situadas 

até 50 metros para fora dos limites da propriedade). 

•	 Polígono para rios com larguras maiores que 10m, lagos e lagoas naturais ou 

reservatórios artificiais, que podem ser delineados manualmente baseados em 

imagens de satélite e dados coletados em campo, considerando como referência 

a linha de máxima cheia, que representa a área ocupada pelo lago em seu nível 

máximo.

Áreas de Preservação Permanente 

Baseado nas informações e camadas temáticas de hidrografia geradas anteriormente, são delimitadas 

as APPs, que servirão para caracterização da situação destas áreas na propriedade e utilização nos mapas 

de modalidades de PSA e de uso e ocupação do solo.

Considerando que não é muito comum nos projetos Produtor de Água áreas com declividades elevadas, 

este manual se limita a apresentar os procedimentos relativos ao estabelecimento das APP hídricas, sendo: 

entorno de nascentes e dos olhos d’água perenes; faixas marginais de cursos d’água naturais; e entorno de 

lagos e lagoas naturais e de reservatórios de água artificiais.

Para procedimentos de delimitação de APP de topo de morros, montes, montanhas e serras e áreas 

com declividade acima de 45°, é necessário buscar procedimentos específicos com a utilização de  MDT 

com boa resolução, como os modelos ALOS-PALSAR e Sentinel, ou outros disponíveis localmente, como 

extraídos de cartas topográficas da região.
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As APP devem ser estabelecidas seguindo às regras e critérios estabelecidos para 

o projeto quanto às orientações da Lei de Proteção da Vegetação Nativa (Novo Código 

Florestal Brasileiro – Lei 12.651/2012), em especial ao previsto no Art. 4º - que estabelece 

as medidas das faixas de proteção – e no Art. 61-A – que trata das regras transitórias 

de necessidade de recomposição de vegetação em áreas “consideradas consolidadas” 

existentes antes de 22 de julho de 2008.

As informações específicas sobre a situação da propriedade quanto à necessidade 

de recomposição de APP, podem ser verificadas previamente no momento de diagnóstico 

inicial da propriedade, a partir da análise das informações do Cadastro Ambiental Rural - 

CAR, bem como de outros sistemas estaduais complementares ao CAR.

Imagens históricas disponíveis no Google Earth podem ser utilizadas para 

verificação das áreas consolidadas, selecionando imagens anteriores a julho de 2008.

APP de cursos d’água corrente (rios e córregos)

Envolve a delimitação de faixas de proteção ao longo dos cursos d’água corrente, definidas com base 

na largura do rio, a partir da margem do leito regular do curso d’água.

Procedimentos:

I.	 A partir do arquivo de rios da propriedade, gerar novo arquivo de polígono de APP de cursos 

d’água, utilizando a ferramenta “Buffer”, considerando os parâmetros das faixas conforme 

legislação aplicável.

•	 No QGIS, a ferramenta “Buffer” está disponível em Vector > Geoprocessing Tools > Buffer.

•	 No ArcGIS, a função “Buffer” está na caixa de ferramentas de Analysis > Proximity > Buffer.

II.	 Definir a faixa de proteção conforme a legislação: A largura da APP de rios varia de acordo 

com a largura do curso d’água (Brasil, 2012).

III.	 Verificar e corrigir se as geometrias geradas não possuem erros topológicos, como 

sobreposições ou espaços vazios entre as faixas de APP e o curso d’água. Use ferramentas de 

correção topológica para garantir a precisão do mapeamento.

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.

IV.	 Na tabela de atributos, adicione os seguintes campos: “Tipo APP” (texto) e “Área (ha)” (número). 

Alimente estes campos manualmente conforme o tipo da APP, neste caso “APP cursos d’água” 

e utilize a função “Field Calculator” para calcular áreas, se necessário.

V.	 Salve ou exporte a camada resultante como um arquivo vetorial shapefile (ou outros conforme 

software utilizado) e nomeie como “APP_cursos_dagua”.

APP de nascentes e dos olhos d’água perenes

Envolve a delimitação de faixas de proteção de nascentes seguindo as diretrizes do Código Florestal 

Brasileiro (Lei nº 12.651/ 2012), que estabelece uma faixa de 50 metros de raio ao redor de qualquer nascente 

ou olho d’água perene.
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Procedimentos:

I.	 Utilize uma camada vetorial contendo a localização das nascentes ou olhos d’água perenes 

para gerar novo arquivo de polígono de APP de nascentes, utilizando a ferramenta “Buffer” 

para criar um círculo com 50 metros de raio ao redor de cada ponto de nascente.

•	 No QGIS, vá em Vector > Geoprocessing Tools > Buffer.

•	 No ArcGIS, use Analysis > Proximity > Buffer.

II.	 Refinar a delimitação das APP: Em áreas onde há várias nascentes próximas umas das outras, 

os buffers podem se sobrepor. Nesse caso, pode ser necessário dissolver os limites para formar 

uma única área contínua de proteção. Utilize a ferramenta de dissolução (dissolve) para 

combinar as áreas de APP sobrepostas em uma única feição.

•	 No QGIS, use Vector > Geoprocessing Tools > Dissolve.

•	 No ArcGIS, use Dissolve em Data Management Tools.

III.	 Verificar e corrigir se as geometrias geradas não possuem erros topológicos, como 

sobreposições ou espaços vazios. Use ferramentas de correção topológica para garantir a 

precisão do mapeamento.

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.

IV.	 Na tabela de atributos, adicione os seguintes campos: “Tipo APP” (texto) e “Área (ha)” (número). 

Alimente estes campos manualmente conforme o tipo da APP, neste caso “APP nascentes” e 

utilize a função “Field Calculator” para calcular áreas, se necessário.

V.	 Salve ou exporte a camada resultante como um arquivo vetorial shapefile (ou outros conforme 

software utilizado) e nomeie como “APP_nascentes”.

APP de lagos e lagoas naturais

Envolve a delimitação de faixas de proteção de lagos naturais seguindo as diretrizes do Novo Código 

Florestal Brasileiro (Lei nº 12.651/2012), que estabelece a largura da faixa de proteção variando conforme a 

dimensão do corpo d’água.

Procedimentos:

I.	 Utilize a camada vetorial contendo a delimitação dos lagos e lagoas da propriedade para 

gerar novo arquivo de polígono de APP de lagos/lagoas, utilizando a ferramenta “Buffer”, 

considerando os parâmetros das faixas conforme legislação aplicável.

•	 No QGIS, vá em Vector > Geoprocessing Tools > Buffer.

•	 No ArcGIS, use Analysis > Proximity > Buffer.

II.	 Verificar e corrigir se as geometrias geradas não possuem erros topológicos, como 

sobreposições ou espaços vazios. Use ferramentas de correção topológica para garantir a 

precisão do mapeamento.

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.

III.	 Na tabela de atributos, adicione os seguintes campos: “Tipo APP” (texto) e “Área (ha)” (número). 

Alimente estes campos manualmente conforme o tipo da APP, neste caso “APP lagos naturais” 

e utilize a função “Field Calculator” para calcular áreas, se necessário.
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IV.	 Salve ou exporte a camada resultante como um arquivo vetorial shapefile (ou outros conforme 

software utilizado) e nomeie como “APP_lagos_naturais”.

Para situações da existência de reservatórios e/ou açudes ou outros corpos d’água artificiais, resultantes 

da construção de barragens ou outras estruturas para retenção de água, utilizar o mesmo procedimento e 

criar arquivo específico e campo “APP corpos d’água artificiais”, utilizando os devidos parâmetros previsto 

em legislação.

Juntando arquivos de APP

Para juntar todos os arquivos de APP em um único arquivo seguir os passos abaixo. 

Procedimentos:

I.	 Carregar as camadas de APP criadas considerando que todas elas estão na mesma projeção. 

Se necessário, reprojete as camadas para que todas estejam na mesma referência. Usar a 

Ferramenta de Dissolução:

•	 QGIS: Vá para Vector > Geoprocessing Tools > Dissolve. Selecione a camada de entrada, que 

será a camada de APP que você deseja unir. Não selecione nenhum campo em “Dissolve 

field” se você quiser unir todas as áreas em um único polígono. Se quiser manter atributos, 

selecione o campo que deseja usar para a dissolução. Defina um nome e local para a 

camada de saída e clique em Run.

•	 ArcGIS: Vá para Geoprocessing > Dissolve. Selecione a camada de entrada, que será a 

camada de APP que você deseja unir. Para a opção Dissolve Fields, escolha os campos 

que você deseja usar para a combinação. Para combinar todas as áreas, deixe em branco. 

Defina o nome e o local do arquivo de saída e clique em OK para executar a ferramenta.

II.	 Salvar o Resultado:

•	 QGIS: A nova camada resultante será criada no QGIS. Você pode exportá-la para um 

shapefile, ou outro formato, clicando com o botão direito do mouse na nova camada e 

selecionando Export > Save Features As.

•	 ArcGIS: O resultado da operação de dissolução será adicionado ao seu projeto. Você pode 

salvar a nova camada em um formato desejado clicando com o botão direito na camada e 

escolhendo Data > Export Data.

III.	 Após a operação de dissolução, verifique a nova camada para garantir que todas as APPs 

foram combinadas corretamente. Certifique-se de que não há áreas duplicadas ou sobrepostas 

indesejadas antes de realizar a dissolução. 

IV.	 Após gerar arquivo de APP geral é necessário cortar a camada de APP pela camada do limite 

da propriedade, resultando em um novo polígono que corresponde às áreas de APP dentro 

dos limites da propriedade. Use a ferramenta de “Interseção” (Intersection):

•	 No QGIS: Vá em “Vector” > “Geoprocessing Tools” > “Intersection”.

•	 No ArcGIS: Use a função “Intersect”, encontrada em “Analysis Tools” > “Overlay” > “Intersect”.

V.	 Após a interseção, revise o polígono gerado para garantir que ele corresponde corretamente 

às APP dentro da propriedade. Se necessário, edite manualmente os polígonos para ajustar 

detalhes ou remover pequenas áreas que possam ter sido incluídas erroneamente.

VI.	 Exporte o polígono resultante para o formato desejado, nomeando-o, por exemplo, como 

“APP geral propriedade XX”.
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Revise todas as informações referentes às situações específicas, especialmente 

quanto a sobreposição com áreas consolidadas, para que a área de APP gerada para a 

propriedade esteja de acordo com a realidade e em conformidade com a legislação.

Possíveis ajustes podem ser feitos a partir do cruzamento da camada de APP com 

camadas de uso do solo e/ou ajustes manuais com a verificação visual na imagem de 

satélite, removendo áreas onde a proteção não se aplica.

Camada de Uso do solo com situação das APP e RL

O objetivo dessa etapa é sobrepor a camada de APP com a camada de uso do solo, gerando uma nova 

camada que contenha informações sobre o tipo de cobertura do solo dentro das áreas de APP. Isso permite 

identificar qual uso está sendo realizado dentro dessas áreas protegidas e gerar um arquivo resultante com 

informações de uso e ocupação do solo atual considerando a situação das áreas de preservação permanente. 

Para criação desta camada, devem ser utilizadas minimamente as camadas geradas anteriormente de:

•	 Camada de uso do solo; e,

•	 APP geral da propriedade.

Procedimentos:

I.	 O primeiro passo é cruzar as informações de uso do solo com a de APP para definir as áreas 

de APP com vegetação nativa e déficit de APP necessárias a restauração. 

Utilize a ferramenta “Union” que permite sobrepor as duas camadas e criar polígonos que 

representam tanto as áreas de APP quanto o uso do solo associado a cada polígono.

•	 No ArcGIS: Vá para “Analysis Tools” > “Overlay” > “Union”. Selecione a camada de APP como 

a primeira entrada e a camada de Uso do Solo como a segunda. Especifique onde salvar o 

novo arquivo de saída e execute a ferramenta.

•	 No QGIS: Vá em “Vetorial” > “Geoprocessamento” > “União”. Escolha a camada de APP e a 

camada de Uso do Solo. Escolha o caminho e nome para salvar e clique em OK para gerar 

a nova camada.

O resultado será uma nova camada que contém a geometria de ambos os conjuntos de dados. Cada 

novo polígono resultante terá atributos da camada de APP (indicando se o polígono está dentro ou fora da 

APP) e atributos da camada de Uso do Solo (indicando o tipo de cobertura ou uso do solo). Desta forma, é 

possível estabelecer se cada polígono está em uma APP e qual o tipo de uso ou cobertura do solo naquele 

local.

II.	 Com o arquivo resultante, criar um campo na tabela de atributos chamado “Situação APP” e 

proceda com a classificação destas. 

Selecione polígonos com Vegetação Nativa nas APP. Use a ferramenta de “Select by Attribute” no 

ArcGIS ou “Consulta por Atributos” no QGIS.

Filtre os polígonos onde o atributo de Uso do Solo seja “Vegetação Nativa” (ou outra denominação 

equivalente) e o atributo de APP indique que está dentro de uma APP. Alimente o campo 

“Situação APP” com a categoria “APP com vegetação”.
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Para gerar as áreas de APP a recuperar, proceda da mesma forma com os polígonos restantes, 

utilizando como filtros características do uso do solo que não corresponde a vegetação nativa, 

como agricultura, pastagem, áreas edificadas ou outros usos não permitidos em APP. Alimente 

o campo “Situação APP” com a categoria “APP a recuperar”.

III.	 Certificar-se que os limites das glebas delimitadas estão claros, sem sobreposições e que 

representam as realidades da área verificada em campo. Pode ser necessário novos ajustes 

manuais na delimitação ou utilize ferramentais de edição:

•	 ArcGIS: “Editor”, “Cut Polygon” e “Merge” para ajustar e corrigir os polígonos.

•	 QGIS: No “Modo de Edição”, use as ferramentas como cortar, mesclar, dividir. 

Use também ferramentas de correção topológica para garantir a precisão do mapeamento.

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.

IV.	 Salve ou exporte a camada resultante como um arquivo vetorial shapefile (ou outros conforme 

software utilizado) e nomeie como “Modalidades_propriedade_xx”.

O arquivo resultante desta ação refere-se às informações de uso e ocupação do 

solo atual considerando a situação das áreas de preservação permanente (APP).

O mesmo procedimento acima pode ser realizado a partir da delimitação dos 

limites da reserva legal, seja ela homologada ou proposta.

Camada das modalidades de PSA

Esta camada é necessária para gerar as informações necessárias ao cálculo dos valores de PSA e para 

compor o mapa de modalidades de PSA. No PIP Ideal, ela representará as características de adequação 

máxima da propriedade em relação a legislação aplicável e as possibilidades de uso futuro a partir da 

implementação de práticas propostas. No PIP Pactuado, ela será ajustada considerando as condições aceitas 

pelo proprietário / produtor após negociação das propostas do PIP Ideal.

A criação desta camada será baseada nas informações geradas no procedimento anterior de criação 

da camada de Uso do solo com situação das APP e RL. 

A partir desta camada, delimitar e ajustar as glebas de modalidades, que serão classificadas conforme 

as modalidades e seus critérios descritos nas tabelas de valoração conforme metodologia definida para o 

projeto. No caso das definições propostas para este manual, os procedimentos para classificação são as 

seguintes:

I.	 Modalidade I – Conservação de Solo, delimitar as áreas de:

•	 Produção Orgânica;

•	 Destinadas a implementação de terraços; e,

•	 Demais áreas de uso que devem receber intervenções ou adoção de práticas.

II.	 Modalidade II – Conservação e Restauração de APP e RL, delimitar polígonos de:

•	 APP com vegetação nativa existente em bom estado de conservação (primária ou em 

estágio médio/avançado de regeneração);
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•	 APP com vegetação nativa existente em estágio inicial de regeneração indicadas para a 

restauração por meio da regeneração natural;

•	 APP destinadas à restauração por meio de plantio e, se for o caso, condução e 

acompanhamento da regeneração natural;

•	 RL com vegetação nativa existente em bom estado de conservação (primária ou em estágio 

médio/avançado de regeneração);

•	 RL com vegetação nativa existente em estágio inicial de regeneração indicadas para a 

restauração por meio da regeneração natural; e,

•	 RL destinadas à restauração da vegetação por plantio e, se for o caso, condução e 

acompanhamento da regeneração natural.

III.	 Modalidade III – Conservação e Restauração de Áreas de Vegetação Nativa excedentes a APP 

e RL:

•	 Áreas com vegetação nativa (excedente à APP e RL) em bom estado de conservação 

(primária ou em estágio médio/avançado de regeneração);

•	 Áreas com vegetação nativa (excedente à APP e RL) existente em estágio inicial de 

regeneração indicadas para a restauração por meio da regeneração natural ou adensamento 

e enriquecimento; e,

•	 Áreas destinadas à recuperação da vegetação por plantio e, se for o caso, condução e 

acompanhamento da regeneração natural.

Procedimentos:

I.	 A delimitação pode ser feita manualmente, baseado nos pontos coletados em campo e na 

verificação visual de imagens de satélites e/ou com uso de ferramentas para criar, cortar e unir 

polígonos, já indicados em procedimentos anteriores.

II.	 Após delimitação certificar-se que os limites das glebas delimitadas estão claros, sem 

sobreposições e que representam as realidades da área verificada em campo. 

III.	 Considere evitar polígonos / glebas muito pequenas pois dificulta a visualização e gestão da 

propriedade. (exemplo área de APP gerada pelo buffer com curvas, sendo que na prática no 

campo é feita uma cerca em linha reta que pode compensar as curvas).

IV.	 Use ferramentas de correção topológica para garantir a precisão do mapeamento.

•	 QGIS: “Fix geometries”.

•	 ArcGIS: “Topology tools”.
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Figura 8 - Representação gráfica da criação da camada de modalidades a partir da camada de uso e ocupação do solo
Fonte: OCT (2024).

V.	 Na tabela de atributos, adicione campos para informações como: “Modalidades” e “Área (ha)”.

Alimente estes campos manualmente conforme os critérios das tabelas de cálculo e utilize a função 

“Field Calculator” para calcular áreas.

Adicione e alimente mais campos de informações, se necessário, por exemplo para especificar os 

usos, tipos de manejo, propostas de intervenções, entre outras.

4.2.3	 Elaboração dos Mapas

Para o modelo de PIP proposto neste manual, devem ser elaborados os seguintes mapas:

•	 Mapa de localização da propriedade;

•	 Mapa de uso do solo da propriedade;

•	 Mapa de modalidades de PSA; e,

•	 Mapas das glebas.

Seguindo orientações técnicas baseadas em normas e boas práticas de representação geográfica da 

International Cartographic Association [ICA] (2014) e nas diretrizes do Manual Técnico de Uso da Terra do 

IBGE (2013), todos os layouts de mapas devem conter elementos essenciais, como simbologia, legenda e 

informações complementares. Isso inclui: título do mapa, nome e logo do projeto, nome do proprietário, 

escala, indicação do norte geográfico, grid em coordenadas UTM, legenda das camadas temáticas, data de 

confecção, entre outros dados relevantes para o projeto.

Considerando que as camadas temáticas (layers) já foram previamente preparadas, as tabelas 

apresentadas nesta seção fornecem orientações para a criação do layout dos mapas a serem incorporados 

no PIP, bem como para sua impressão, quando necessária.

Os mapas devem preferencialmente ser produzidos em formato A4, modo retrato, para facilitar sua 

inserção em relatórios de acompanhamento do projeto. No entanto, é recomendável também a produção de 
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mapas em formatos maiores, como A3 ou A2, para serem entregues aos proprietários. Mapas em tamanhos 

ampliados são bem recebidos pelos produtores, pois ajudam a promover maior engajamento, permitindo 

uma visualização mais detalhada da representação gráfica de sua propriedade.

Nesta seção, será apresentado o procedimento padrão para a elaboração do layout dos mapas, 

aplicável a todos os mapas necessários ao PIP. Em seguida, serão detalhadas as especificidades de cada tipo 

de mapa, com foco na apresentação do conteúdo e nas camadas (layers) necessárias para cada caso.

Procedimento geral para elaboração dos Layouts

I.	 Certifique-se de que todas as camadas necessárias (uso do solo, hidrografia, APP, limite da 

propriedade etc.) estão no mapa.

Ajuste a simbologia e as cores das camadas conforme sugerido nas orientações específicas de 

cada mapa, apresentadas na sequência deste procedimento.

II.	 Criar um Novo Layout:

•	 No ArcGIS: Acesse a aba “Insert” e selecione “New Layout”. Escolha o tamanho e a orientação 

(paisagem ou retrato).

•	 No QGIS: Vá em “Project” > “Layouts” e clique em “New Print Layout”. Escolha um nome 

para o layout e defina o tamanho do papel e a orientação (A4, A3, paisagem, retrato etc.).

III.	 Adicionar o Mapa ao Layout:

•	 ArcGIS: Na aba “Layout View”, clique em “Insert” > “Map”.

•	 QGIS: Na aba “Print Layout”, vá em “Add Item” > “Add Map”. Desenhe a área onde o mapa 

será inserido e juste o zoom do mapa e a extensão visível conforme necessário.

IV.	 Aplicação de Simbologia:

•	 ArcGIS: Vá em “Layer Properties” e defina a simbologia baseada no campo de uso do solo 

para representar as diferentes classes com cores.

•	 QGIS: Na aba “Layer Properties” > “Simbology”, escolha a opção “Categorized”, selecione o 

campo correspondente e atribua cores às categorias.

V.	 Adicionar Elementos ao Layout:

•	 ArcGIS: Vá em “Insert” e selecione a função desejada: “Legend; “Escale bar”; “North Arrow”; 

Text” para adicionar o título ao mapa e/ ou para citar a fonte dos dados;

•	 QGIS:  Vá em “Add Item” e selecione a função desejada: “Add Legend”; “Add Scale Bar”; “Add 

North Arrow”; > “Add Label” para título e outros textos.

VI.	 Alinhe todos os elementos e ajuste o layout conforme a necessidade e personalize o layout 

com logos do projeto, nome da propriedade, entre outros elementos visuais, se necessário.

VII.	 Exportar o Layout:

•	 ArcGIS: Vá em “File” > “Export” e escolha o formato desejado (PDF, PNG, TIFF etc.).

•	 QGIS: Vá em “Layout” > “Export as PDF” ou escolha outro formato como PNG ou TIFF.

Mapa de localização da propriedade na área do projeto

Trata-se do mapa de localização (Figura 9) abrangente da propriedade na bacia hidrográfica e/ou na 

área do projeto que deve ser inserido na parte inicial do tópico que trata da situação atual e caracterização 

da propriedade. 
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Figura 9 - Exemplo de mapa de localização da propriedade na área do projeto
Fonte: Elaborado por Carlos Wroblewski e Renato Atanazio

A Tabela 2 apresenta as orientações quanto a sugestão dos layers necessários e quais cores utilizar 

como simbologia.

Tabela 2 - Orientações para elaboração do layout do mapa de localização da propriedade4

Camadas Temáticas / Layers Tipo de feição Cor simbologia*

Limites da propriedade Polígono amarela

Limite da bacia hidrográfica Polígono cinza claro

Limite da área de abrangência do Projeto Polígono cinza escuro

Malha hidrográfica Linha ou multilinha azul

Malha viária (principais estradas) Linha ou multilinha vermelho ou laranja

Indicação de pelo menos um ponto de referência Ponto amarela

Limites municipais ou estaduais Linha ou multilinha
Preto ou cinza - linhas 

pontilhadas ou tracejadas

Nome propriedades / proprietários confrontantes Descrição branca

Imagem de satélite Raster

Mapa de uso e ocupação do solo

Trata-se do mapa de uso e ocupação do solo atual necessário à caracterização da propriedade quanto 

ao seu estado atual no momento de entrada no projeto.

4	 Fonte: Renato Atanazio. *Baseado em IBGE (2013).
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Ressalta-se que as classes de vegetação apresentadas aqui são apenas sugestões 

genéricas baseado no Manual de Uso do Solo (IBGE, 2013), as quais podem ser ajustadas 

de acordo com a classificação mais adequada para a região, como por exemplo o 

Estudo de Classificação Fitogeográfica Regional, realizado pela EMBRAPA em parceria 

com outras instituições.

Figura 10 - Exemplo de mapa de uso e ocupação do solo da propriedade
Fonte: Elaborado por Carlos Wroblewski e Renato Atanazio.

Este mapa é utilizado também no tópico que trata da situação atual e caracterização da propriedade 

no PIP. A Tabela 3 apresenta as orientações quanto a sugestão dos layers necessários e quais cores utilizar 

como simbologia.
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Tabela 3 - Orientações para elaboração do layout do mapa de uso do solo da propriedade5

Camadas Temáticas / Layers Tipo de feição Cor simbologia*

Limites da propriedade Polígono Preta ou vermelha

Hidrografia (rios até 10m de largura) Linha ou multilinha Azul

Hidrografia (nascentes) Ponto Azul

Hidrografia (lagos, lagoas, reservatórios, açudes e rios acima 

10m de largura)
Polígono Azul

Camada de uso do solo

Estradas internas Polígono Rosa

Culturas temporárias (grãos, 

legumes e hortaliças etc.)
Polígono Amarela

Culturas perenes (frutíferas, 

café, cana, vinhedos etc.)
Polígono Laranja claro

Silvicultura Polígono Laranja médio

Pastagem Polígono Laranja escuro

Solo exposto ou áreas 

degradadas
Polígono Marrom ou cinza

Vegetação nativa em bom 

estado de conservação 

(primária ou em estágio 

médio/avançado de 

regeneração)

Polígono Verde médio

Vegetação nativa em estágio 

inicial de regeneração
Polígono Verde claro

Áreas de Preservação Permanente (APP) Polígono Preta com hachurado

Reserva Legal (RL) Polígono Verde escuro com hachurado

Mapa das modalidades

Este mapa apresenta as informações sobre as áreas que farão parte do projeto, passíveis de valoração 

conforme critérios estabelecidos na metodologia utilizada.

Para elaboração do PIP Ideal, este mapa apresenta a situação de adequação hidroambiental total da 

propriedade, sendo a base da negociação com o proprietário/produtor. O mapa de modalidades “ideal” é 

o ponto de partida para uma futura negociação com o proprietário rural sobre as áreas que serão de fato 

inseridas no projeto Produtor de Água.

Para elaboração do PIP Pactuado, este mapa de modalidades deve ser ajustado conforme as ações 

aceitas após negociação com o proprietário / produtor. Caso a negociação resulte do aceito de 100% das 

ações proposta no PIP Ideal, este mapa se mantém o mesmo para o PIP Pactuado.

5	 Fonte: Renato Atanazio. *Baseado em IBGE (2013).
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Figura 11 - Exemplo de mapa de modalidades de PSA
Fonte: Elaborado por Carlos Wroblewski e Renato Atanazio

A Tabela 4 apresenta as orientações quanto à sugestão dos layers necessários e quais cores utilizar 

como simbologia.
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Tabela 4 - Orientações para elaboração do layout do mapa do PIP de Modalidades6

Camadas Temáticas / Layers Tipo de feição Cor simbologia*

Limites da propriedade Polígono Preta

Hidrografia (rios até 10m de largura)
Linha ou 

multilinha
Azul escuro

Hidrografia (nascentes) Ponto Azul escuro

Hidrografia (lagos, lagoas, reservatórios, açudes e rios acima 10m de largura) Polígono Azul escuro

Estradas internas Polígono Rosa

Modalidade I: Conservação de 

solo

Glebas (Uso e prática X) Polígono

Tons de amarelo e 

laranja

Glebas (Uso e prática Y) Polígono

Glebas (Uso e prática Z) Polígono

Áreas onde haverá implementação de terraços Polígono

Áreas de produção orgânica Polígono

Instalações futuras de infra de saneamento Ponto

Modalidade II: Conservação e 

Restauração de APP e RL

APP com vegetação nativa existente em bom estado 

de conservação (primária ou em estágio médio/

avançado de regeneração)

Polígono

Tons de azul

APP com vegetação nativa existente em estágio 

inicial de regeneração indicadas para a restauração 

por meio da regeneração natural

Polígono

APP destinadas à restauração por meio de plantio 

e, se for o caso, condução e acompanhamento da 

regeneração natural

Polígono

RL com vegetação nativa existente em bom estado 

de conservação (primária ou em estágio médio/

avançado de regeneração)

Polígono

RL com vegetação nativa existente em estágio 

inicial de regeneração indicadas para a restauração 

por meio da regeneração natural

Polígono

RL destinadas à restauração da vegetação por plantio 

e, se for o caso, condução e acompanhamento da 

regeneração natural

Polígono

Modalidade III: Conservação 

e Restauração de Áreas de 

Vegetação Nativa excedentes a 

APP e RL

Áreas com vegetação nativa (excedente a APP e RL) 

em bom estado de conservação (primária ou em 

estágio médio/avançado de regeneração)

Polígono

Tons de verde

Áreas com vegetação nativa (excedente a APP e RL) 

existente em estágio inicial de regeneração indicadas 

para a restauração por meio da regeneração natural 

ou adensamento e enriquecimento

Polígono

Áreas destinadas à recuperação da vegetação 

por plantio e, se for o caso, condução e 

acompanhamento da regeneração natural. 

Polígono

6	 Fonte: Renato Atanazio. *Baseado em IBGE (2013).
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Observações:

•	 Os polígonos das glebas devem ser divididos por modalidade, tipos de uso e 

estratégia/prática sugerida, que devem se referir às classes indicadas nas tabelas 

de valoração;

•	 Para estradas internas, utilizar polígono, não linha. Ou seja, as estradas também 

são glebas; e,

•	 As glebas não podem se sobrepor umas às outras, independente da modalidade. 

Mapas de detalhamento das glebas

No PIP Pactuado, que apresenta informações mais detalhadas sobre as práticas a serem adotadas na 

propriedade, recomenda-se a criação de mapas específicos de cada gleba inserida no projeto para facilitar 

a visualização dos detalhes na negociação das práticas com o proprietário.

Figura 12 - Exemplo de mapa de detalhamento de gleba
Fonte: Elaborado por Carlos Wroblewski e Renato Atanazio.

Estes mapas podem ser inseridos junto a descrição do projeto técnico estabelecido para cada uma 

das glebas no tópico do PIP referente ao detalhamento das glebas.

Os mapas das glebas poderão ser elaborados de forma individual para cada gleba ou podem ser 

agrupadas várias glebas no mesmo mapa quando apresentarem as mesmas características técnicas. 

Estes mapas devem ser gerados a partir das informações do mapa de modalidades, podendo trazer 

novas informações mais detalhadas conforme projeto técnico estabelecidos para as práticas, tais como:

•	 Linhas com traçado e localização das práticas mecânicas sugeridas;
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•	 Pontos e/ou linhas com o posicionamento das estruturas de condução e captação de águas 

pluviais em estradas internas como valetas, lombadas, caixas secas e barraginhas;

•	 Linhas com traçado de cercas e aceiros para todas as áreas da modalidade II e III que exigirem 

esta estratégia para conservação ou para restauração; e,

•	 Entre outros detalhes necessários a implementação das práticas estabelecidas.

4.3	 Etapa 3 – Cálculo dos valores do PSA 

Conforme já mencionado, a metodologia proposta considera três modalidades distintas de PSA:

•	 Modalidade I - Conservação de Solo;

•	 Modalidade II - Restauração ou Conservação de APP e/ou RL; e,

•	 Modalidade III - Conservação de remanescentes de vegetação nativa

Como calcular?

Basicamente, o valor total do PSA será a soma dos valores calculados para cada modalidade, sendo 

que o valor de PSA total de cada modalidade será o produto da multiplicação do VRE pelos índices contidos 

nas tabelas de cálculo, conforme características identificadas na propriedade, descritas nos critérios de 

valoração.

O VRE sugerido neste manual é de R$100,00 ha/ano. Este valor é aplicável a todas as modalidades. 

Procedimentos para cálculo da modalidade I – Conservação de Solo:

Esta modalidade visa incentivar o produtor rural a adotar práticas de conservação de solo, em áreas 

de pastagens e lavouras, que diminuem a erosão e contribuem para a redução da sedimentação nos corpos 

d’água. Os valores de PSA por hectare são calculados com base no PAE e outros critérios.

Procedimentos para cálculo da Modalidade II - Restauração ou Conservação de APP e/ou RL

Esta modalidade visa contribuir com o produtor rural na restauração e/ou conservação da vegetação 

nativa em áreas que já desempenham um papel na proteção ambiental, como APPs e RLs existentes ou 

propostas. Os valores de PSA por hectare referente à restauração e conservação de APP e/ou RL serão o 

produto da multiplicação entre o valor de referência pelos índices específicos associados à modalidade. 

Procedimentos para cálculo da Modalidade III - Conservação de remanescentes de 
vegetação nativa

Visa incentivar o produtor rural a recuperar, conservar e proteger a vegetação nativa remanescente de 

sua propriedade, quando excedentes à APP e à RL existente ou proposta.

Esta modalidade não possui tabela de cálculo. Os valores de PSA por hectare referente à restauração 

e conservação de vegetação nativa excedentes, será produto da multiplicação do VRE por 3. No caso de 

a área necessitar de investimento do projeto em ações como plantios de enriquecimento da vegetação o 

valor a ser pago por hectare será de 2,5 vezes o valor de referência.  Para mais informações sobre cálculo de 

PSA considerar outros materiais e publicações do Programa Produtor de Água.
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4.4	 Etapa 4 – Preenchimento do PIP

Para cálculo do valor total de PSA da propriedade, basta somar todos os valores 

obtidos para cada modalidade.

Conforme já mencionado neste material, o processo de elaboração do PIP considera dois momentos 

distintos e complementares, sendo o primeiro momento a elaboração do PIP Ideal e, posteriormente, o PIP 

Pactuado.

O PIP Ideal é a primeira versão do PIP elaborada, que tem como objetivo apresentar as propostas de 

adequação máxima da propriedade, em conformidade com as diretrizes e prioridades do projeto e com a 

legislação vigente. Por se tratar de uma proposta para ser negociada com o proprietário / produtor, o PIP 

Ideal pode apresentar informações mais objetivas e diretas.

Já o PIP Pactuado é a versão final e completa do PIP que servirá de base para o cálculo dos valores de 

PSA, elaboração de contratos, implementação das práticas conservacionistas e monitoramento futuro dos 

serviços ambientais prestados.

 Contudo, isso não significa que o PIP pactuado seja mais trabalhoso que o PIP Ideal, pois todas as 

informações definidas no PIP Ideal serão utilizadas no PIP Pactuado após negociações e aprovação. O PIP 

Ideal é, portanto, a primeira versão do PIP, e o PIP Pactuado a versão final, detalhada, que se caracteriza 

como o projeto executivo de planejamento da propriedade.

O modelo de PIP está apresentado nos anexos deste manual a partir da estrutura 

de tópicos e orientações quais informações deverão ser inseridas em cada um deles, 

utilizando os procedimentos apresentados, referente à parte prática de elaboração do 

PIP. No final de cada tópico há recomendações gerais e indicação se aquele conteúdo 

deve ser considerado no PIP Ideal e no PIP Pactuado.

A Tabela 5 apresenta de forma resumida quais as informações podem ser inicialmente elaboradas 

para o PIP Ideal, bem como quais delas deverão ser ajustadas e/ou complementadas após negociações com 

o proprietário.
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Tabela 5 - Resumo das informações componentes do PIP Ideal e do PIP Pactuado7

Informações / tópicos PIP Ideal PIP Pactuado

CAPA X

1 - Introdução: Resumo e caracterização da área do 
projeto*

X X

2 - Dados de identificação da propriedade e do 
responsável*

X X

3 - Situação atual / caracterização da propriedade* X X

4 - Mapa modalidades - Ideal* X X

5 - Mapa modalidades – Pactuado** X

6 - Quadro resumo de áreas e valores PSA** X X

7 - Proposta de adequação*** X X

8 - Cronograma de atividades de desembolsos X

9 - Planilha de custos das intervenções X

10 - Observações gerais e recomendações para 
monitoramento

X

11 - Proposta de concordância**** X X

* Elaborar as informações no PIP Ideal e manter as mesmas no Pactuado.

** Elaborar as informações no PIP Ideal e ajustá-las para o Pactuado representando as propostas aceitas. Caso haja 100% de aceite, 
apenas informar aceite total e manter informações.

*** No PIP Ideal pode ser mais resumida, sem detalhes de projeto técnico.

**** No PIP Ideal a tabela segue em branco para preenchimento e no Pactuado ela é apresentada, escaneada, preenchida e assinada.

4.5	 Etapa 5 – Apresentação e negociação do PIP 

Após a elaboração do PIP Ideal, é agendada uma nova visita para apresentação e apreciação pelo 

proprietário/produtor. Nessa etapa, o técnico negocia com o proprietário as ações necessárias para adequar 

a propriedade em conformidade com a legislação vigente e aos critérios do projeto, viabilizando sua 

participação. 

Como o projeto é de adesão voluntária, é possível que o produtor não aceite todas as propostas. 

Por isso, a negociação exige uma abordagem colaborativa, baseada em comunicação eficaz, respeito às 

tradições locais e habilidades de mediação. O técnico deve adaptar sua linguagem para traduzir conceitos 

técnicos de forma clara, considerando o nível de conhecimento do produtor e o contexto cultural local.

Nesta fase, é fundamental que o técnico ouça atentamente o produtor, que possui o conhecimento 

prático sobre a dinâmica da água na propriedade, identificando pontos de escoamento, áreas mais suscetíveis 

à erosão e os danos causados ao longo do tempo. Esse saber empírico, construído pela vivência direta com 

o ambiente, complementa e enriquece a análise técnica, que muitas vezes se baseia apenas em mapas, 

imagens de satélite e diagnósticos prévios.

Além disso, é crucial considerar o uso econômico planejado pelo produtor, como suas metas de 

produção e necessidades futuras. Esse diálogo permite alinhar as intervenções propostas no PIP com a 

realidade e os objetivos do proprietário, garantindo que as práticas implementadas estejam integradas ao 

manejo sustentável da área.

7	 Fonte: Renato Atanazio.
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Essa abordagem busca identificar as necessidades específicas do agricultor e propor soluções viáveis 

que conciliem essas demandas com os objetivos do projeto. O resultado é um plano mais adaptado à 

realidade do produtor, promovendo maior aceitação e adesão às práticas recomendadas, além de assegurar 

a sustentabilidade econômica e ambiental da propriedade.

Foto 11  – Processo de negociação do PIP
Leonardo Petrocelli / Banco de Imagens ANA

A negociação deve ser formalizada por meio da “Proposta de Concordância do Produtor Rural” 

prevista no PIP Ideal. Este documento deve ser preenchido pelo responsável técnico, relacionando o mapa 

de modalidades (Ideal) e descrevendo resumidamente as ações acordadas, com a referência das glebas, as 

intervenções previstas e quantificação das áreas correspondentes em hectares (Tabela 6).

Tabela 6 - Modelo de proposta de concordância do proprietário ou produtor rural8

MODALIDADE I – Conservação de Solos

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)

MODALIDADE II – Conservação e Restauração de APP e RL

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)

MODALIDADE III – Conservação de Vegetação Nativa Excedente

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)

Este formulário deve ser preenchido e assinado pelo proprietário / produtor e pelo responsável 

técnico e encaminhado a instituição responsável pelo contrato. Na ocasião da negociação, o proprietário 

ou produtor recebe uma via do PIP ideal com a proposta de concordância preenchida e assinada. 

8	 Fonte: Renato Atanazio.
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Essa contraproposta do produtor rural pode ser utilizada no ranqueamento para fins de contratação. A 

UGP pode definir diferentes formas para ranqueamento a depender do problema a ser atacado na bacia, tais 

como: i) propostas que mais se aproximarem do projeto Ideal terão maior prioridade na contratação; ou, 

ii) estabelecer “pesos” diferentes para cada modalidade. Por exemplo, se o grande problema é erosão - um 

percentual maior de aceite do PIP Ideal nas glebas de conservação de solo pode dar uma pontuação maior, 

mesmo que o produtor tenha um grande excedente de vegetação nativa, já que o problema na bacia, neste 

caso hipotético, não é falta de cobertura vegetal nativa.

4.6	 Etapa 6 – Elaboração do PIP Pactuado

Após a negociação, o PIP Ideal deve ser ajustado para refletir o acordo entre as partes quanto às 

intervenções a serem implementadas, transformando-se em um projeto técnico mais detalhado para 

execução e monitoramento das atividades, chamado PIP Pactuado.

Este é a base para o cálculo dos valores de PSA, elaboração do contrato, implementação de práticas 

conservacionistas e monitoramento dos serviços ambientais.

Nos casos em que o produtor aceita 100% das ações previstas no PIP Ideal, não é necessário fazer 

ajustes ou recalcular as informações. Basta complementar o documento com os detalhes técnicos para 

execução das ações propostas.

Para elaborar um PIP pactuado e eficaz, os seguintes aspectos devem ser levados em conta:

•	 Identificação de áreas prioritárias para intervenções - Considerar os locais críticos indicados 

pelo produtor, mas também incorporando análises técnicas relativas aos objetivos e prioridades 

do projeto.

•	 Adaptação às condições socioeconômicas do produtor - Garantir que as práticas sugeridas 

sejam viáveis, tanto financeiramente quanto operacionalmente.

•	 Respeito ao conhecimento tradicional e às práticas locais - Muitas vezes, os produtores já 

utilizam soluções empíricas eficazes que podem ser otimizadas ou incorporadas ao PIP.

Figura 13 - Mapa Ideal (esq.) x Mapa Pactuado (dir.)
Fonte: Elaborado por Carlos Wroblewski e Renato Atanazio.
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As informações sobre o conteúdo que deve ser ajustado/complementado na elaboração do PIP 

Pactuado, estão apresentadas de forma resumida na Tabela 5 (tópico 4.4) com resumo das informações 

componentes do PIP Ideal e do PIP Pactuado. Já os detalhes e orientações para ajustes e complementos 

estão apresentados em cada um dos tópicos do modelo de PIP, Anexo I deste manual. 

4.7	 Assinatura de contrato e pagamentos

O contrato formaliza o compromisso do proprietário de adotar práticas conservacionistas em troca 

de compensações financeiras ou outros incentivos. No caso do projeto incluir PSA, o contrato entre o 

proprietário e a instituição pagadora do PSA é necessário para garantir clareza e segurança jurídica para 

ambas as partes envolvidas. 

Embora o contrato seja firmado com o proprietário após a elaboração e pactuação do PIP, há algumas 

regras que precisam estar definidas e claras para os técnicos no momento de elaboração do PIP, pois 

deverão ser apresentadas ao proprietário nos momentos de negociação das práticas e até mesmo quando 

da explicação das características do projeto na conversa inicial com o proprietário.

Um fator importante para contratação é a definição da documentação da propriedade que será 

exigida, pois em diversas regiões do país a regularização fundiária é precária, resultando numa deficiência 

de documentação por parte dos proprietários. Os projetos, em muitas regiões, têm encontrado dificuldades 

para iniciar suas atividades e efetuar os primeiros contratos, devido a essa ausência de informações oficiais 

sobre as propriedades e seus possuidores. 

A correta identificação do proprietário é essencial para determinar: (1) quem possui o direito de firmar 

compromissos; (2) quem responde pelas obrigações assumidas; e, quando couber, (3) quem pode receber 

os valores decorrentes do contrato e dar a quitação necessária. Em alguns casos, o usuário da terra não é 

o proprietário, mas sim o possuidor, usufrutuário, locatário, arrendatário, meeiro, inventariante, herdeiro, 

comodatário, credor hipotecário, fiel depositário, ou condômino, entre outros - nos termos da lei ou do 

contrato feito entre proprietário e possuidor do imóvel (Fundação Grupo Boticário, 2012).

O PIP é composto pelas recomendações técnicas necessárias para orientar as ações 

de conservação e manejo na propriedade, enquanto o contrato apresenta as cláusulas 

jurídicas que garantem o cumprimento dos compromissos assumidos. Ou seja, o PIP 

detalha o “como fazer” em termos técnicos, enquanto o contrato se concentra em “como 

garantir”, estabelecendo as responsabilidades das partes, os direitos e as consequências 

em caso de descumprimento das regras.

Dentre os documentos que podem comprovar a propriedade ou posse das propriedades estão 

(exemplos):

•	 Matrículas atualizadas ou escrituras (certidão original emitida pelo Cartório);

•	 Cópias autenticadas de contratos particulares;

•	 Certificado de cadastro de imóvel rural emitido pelo Incra em nome do proprietário/possuidor; e,

•	 Cópia de processos relacionados à titularidade da área (usucapião, formal de partilha, entre outras).
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Foto 12 – Assinatura de contratos em projeto do Programa Produtor de Água com PSA (SC)
André Targa Cavassani/Banco de Imagens ANA

Em alguns projetos a análise da documentação é feita pela instituição executora através de seus 

departamentos jurídicos e, portanto, cabe a eles a definição dos documentos que serão solicitados aos 

proprietários. 

Além disso, outros detalhes devem ser previamente discutidos e definidos para composição do 

conteúdo do contrato, os quais envolvem os seguintes pontos:

•	 Prazos e vigência: Refere-se ao prazo de duração do contrato, para a implementação das 

ações e a periodicidade dos monitoramentos. A maior parte dos projetos vinculados ao 

Programa Produtor de Água adota contratos com validade de 3 a 5 anos, com possibilidade 

de renovação ao seu término;

•	 Forma de pagamento (quando o projeto incluir PSA): Se transferências bancárias diretamente 

aos beneficiários, em conta específica vinculada ao projeto e indicação de formas de 

atualização dos valores;

•	 Periodicidade e condições para pagamentos (quando o projeto incluir PSA): Cláusula que 

vincula o cronograma de atividade ao financeiro apresentado no PIP. Geralmente os projetos 

efetuam pagamentos anuais condicionados ao cumprimento de metas pré-estabelecidas e 

verificadas periodicamente se as condições contratadas foram atendidas;

•	 Critérios de monitoramento e verificação: Especifica os métodos de monitoramento, 

responsáveis pela verificação e frequência das avaliações. Geralmente as vistorias de 

monitoramento são anuais;

•	 Sanções e rescisão: Cláusulas sobre o que ocorre em caso de descumprimento das obrigações 

ou de rescisão do contrato antes do prazo acordado;

•	 Transferência de propriedade: Orienta sobre o que acontece em caso de venda da propriedade 

durante a vigência do contrato;

•	 Clareza sobre obrigações legais: Certificar-se de que o contrato não cria conflitos com 

obrigações legais já existentes ou outras exigências regulatórias;

•	 Possibilidade de renovação: Previsões para a renovação ou extensão dos contratos, de acordo 

com o cumprimento das metas; e,

•	 Regras para revisão e/ou alteração dos PIPs: Condições para revisão (mudanças nas condições 

ambientais ou nas metas do projeto), procedimento de solicitação de revisão, bem como 
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responsáveis pela validação de modo a assegurar que as mudanças continuam a atender os 

objetivos do projeto.

Esses elementos ajudam a garantir que o contrato seja justo, compreensível e aplicável, além de 

fornecer segurança para que as ações de conservação sejam efetivas ao longo do tempo.

Realização dos Pagamentos 

Com a assinatura do contrato, as ações e práticas previstas podem ser implementadas e monitoradas 

por meio de visitas de acompanhamento. Na primeira vistoria, caso as práticas estabelecidas no cronograma 

tenham sido executadas satisfatoriamente, o pagamento pode ser realizado.

Esses pagamentos podem ser feitos por diversos instrumentos financeiros, como cheque, depósito, 

transferência bancária, cartões corporativos para produtores rurais, cédulas de produto rural, entre outros. 

A periodicidade dos pagamentos é definida a mais adequada pelo pagador pelos serviços ambientais e em 

comum acordo com o produtor rural (ANA, 2025).

Cada projeto decide a frequência ideal para os pagamentos. Muitos optam pelo pagamento anual, 

pois reduz o tempo de administração e facilita o cronograma de monitoramento, exigindo uma equipe 

menor para essa tarefa. 

É desejável que os pagamentos sempre ocorram de acordo com as avaliações periódicas (verificações) 

do grupo gestor quanto ao cumprimento da manutenção das intervenções, na forma detalhada pelos 

respectivos contratos firmados entre produtor e pagador do PSA. 

4.8	 Implementação das intervenções e monitoramentos

Com o contrato formalizado, inicia-se a execução das intervenções em campo, com a contratação 

dos serviços de implementação das práticas previstas, baseados no conjunto de PIPs elaborados para o 

período. 

Após a seleção das áreas mais aptas a receberem as intervenções, é essencial preparar as bases 

para o monitoramento dos resultados que essas mudanças possam gerar.. Essa etapa, realizada antes da 

implementação das intervenções propostas em cada PIP, é importante para embasar o acompanhamento 

da evolução que o projeto trará ao longo do tempo (ANA, 2025).

Procede-se com a caracterização detalhada de uma área específica antes da implementação de tal 

prática, servindo como ponto de referência para o monitoramento futuro. Com ela, é possível verificar se 

o projeto contribuiu para a manutenção e/ou melhoria dos serviços ambientais na área contratada. Ela 

também orienta as atividades de monitoramento, que avaliarão se as práticas adotadas estão sendo efetivas 

para atendimento aos objetivos do projeto e minimização dos problemas apresentados na bacia. 

Em alguns casos, quando há um longo intervalo entre a assinatura do contrato e 

a implementação das práticas, pode ser necessário o ajuste e elaboração de um novo 

PIP. Isso pode ocorrer devido a entraves burocráticos, como morosidade na licitação de 

serviços, troca de titularidade da terra ou desistência de acordos. Nessas situações, é 

preciso repactuar as práticas e atualizar o PIP para atender às novas condições.

O monitoramento das propriedades tem como principal objetivo verificar o cumprimento dos acordos 

estabelecidos no PIP e no contrato. Quando o projeto inclui PSA, o pagamento é efetuado somente se 

houver comprovação de que o serviço foi fornecido. 
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Esse momento possibilita também que os proprietários e produtores comprovem melhorias e ações 

previstas inicialmente, podendo em uma possível renovação dos contratos, aumentar a área e o valor do 

PSA. 

O monitoramento também serve para o proprietário receber orientações técnicas a respeito do 

manejo das suas terras e do melhor cumprimento do seu contrato. É comum que ao longo do projeto 

surjam questões e novas demandas por parte dos proprietários, sendo essa uma excelente oportunidade 

para esclarecer dúvidas relativas aos objetivos do projeto, à importância da conservação das áreas naturais 

e à implantação de boas práticas agrícolas nas áreas produtivas. 

 

Foto 13  –  Visitas de monitoramento em propriedade rurais (SC)
André Targa Cavassani/Banco de Imagens ANA

É um momento em que o proprietário geralmente está aberto a receber novas informações, 

compreendendo os benefícios sociais, econômicos e ambientais do do projeto. Quando há pagamento de 

PSA, é importante que o proprietário entenda claramente por que está recebendo e como foi estabelecido 

o valor pago. O monitoramento é a oportunidade de catalisar o efeito educativo do projeto. 

O PIP possui um cronograma de atividades e, quando couber, de pagamentos, sendo o período de 

monitoramento estabelecido com antecedência. Convém estabelecer um cronograma de monitoramento 

para otimizar o deslocamento dos técnicos em campo, diminuindo os custos de manutenção do projeto. 

Além disso, os proprietários devem estar cientes de que serão visitados com a frequência estabelecida 

em contrato.
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ANEXO A – MODELO DE PROJETO INDIVIDUAL DE 
PROPRIEDADE

Capa 

Dados de identificação: Nome e logo do projeto, município, UF, nome e código da propriedade e data.

1	 Introdução 

1.1	 Resumo sobre o projeto

Texto com resumo, histórico e contexto do projeto: qual a iniciativa / objetivos / principais parceiros / 

localização do projeto / justificativa / problema a ser enfrentado.

1.2	 Caracterização da área do projeto

Conforme disponibilidade de informações, incluir: mapa de localização da bacia e/ou área do projeto 

/ informar áreas prioritárias na bacia e suas categorias / se há Unidades de Conservação, informar suas 

diretrizes de uso em zona de conservação e/ou de amortecimento.

Observações:

Estas informações podem ser de interesse do Proprietário/Produtor para entendimento dos motivos e 

consequências da adoção das práticas em sua propriedade.

Considerando que estas informações serão comuns aos PIPs de todas as propriedades da bacia, 

recomenda-se já as inserir no PIP Ideal.

Recomenda-se também inserir informações resumidas, somente para contextualização, que não passe 

de 2 páginas.

Este tópico deve ser apresentado no PIP Ideal e pactuado 
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2	 Identificação da Propriedade e do Responsável/Proprietário/Produtor

DADOS DO RESPONSÁVEL PELA PROPRIEDADE

NOME: RELAÇÃO: (proprietário/arrendatário/

assentado/posseiro/caseiro/outros)

RG: CPF: TEL: E-MAIL:

PROFISSÃO: RESIDE NA PROPRIEDADE? (sim ou 

não)

IDADE: GRAU DE ESCOLARIDADE:

IDENTIDADE DE GÊNERO: (Mulher/Homem/Outro/Prefiro não 

informar)

COR OU RAÇA/

ETNIA:

NOME CÔNJUGE: (devem assinar os 

documentos em conjunto caso sejam 

casados em comunhão de bens)

DADOS DA PROPRIEDADE

NOME PROPRIEDADE: ÁREA TOTAL (Ha): 

ENDEREÇO: LOCALIDADE / COMUNIDADE:

TRECHO DA BACIA: COORDENADAS DA SEDE: DOC. OCUPAÇÃO DA TERRA:

REGISTRO NO CAR: DATA DE CADASTRO NO CAR: Nº INSCRIÇÃO NO PROJETO

NOME SÓCIO(S) DA POROPRIEDADE: PROPRIEDADE ESTÁ SENDO 

INVENTARIADA?

DESCRIÇÃO DO ACESSO A PROPRIEDADE:

CARACTERIZAÇÃO DA PROPRIEDADE

TIPO PROPRIEDADE: (agricultura familiar / veraneio ou lazer / comodato / outros) PROPRIEDADE É SUA PRINCIPAL 

FONTE DE RENDA? (sim ou não)

CULTURAS PRODUZIDAS: 

PRINCIPAL ATIVIDADE: PRODUÇÃO ORGÂNICA? (certificado, 

em processo, não)

ESTRUTURA DE SANEAMENTO: 

(fossa séptica / sumidouro / 

biodigestor / outros)

FONTE DE ÁGUA POTÁVEL: DISPOSIÇÃO DE RESÍDUOS SÓLIDOS: 

(coleta pública / queima / outros)

HÁ CONECTIVIDADE ENTRE AS ÁREAS NATURAIS? (bloco único, acima de 50% do total, 

não)

POSSUI ACEIRO? (toda propriedade, 

parcial, não)

PROPRIEDADE INCLUÍDA EM OUTROS PROJETOS? QUAIS? Nº PESSOAS RESIDENTES NA 

PROPRIEDADE:

HÁ ÁREAS COM RESTRIÇÕES LEGAIS COMO TACs, TCRAs etc.? Nº DE EMPREGADOS NA 

PROPRIEDADE (EXTERNAS):

POR QUE QUER PARTICIPAR DO PROJETO?

Observações:

As informações sobre Dados do Responsável e da Propriedade poderão ser utilizadas como formulário 

de inscrição no projeto no período de chamamento.

As informações sobre Caracterização da Propriedade são relevantes para futuros monitoramentos e 

avaliações do projeto e poderão ser incrementadas de acordo com a pertinência e necessidade.



Série Manuais do Programa Produtor de Água: Vol.3 Elaboração de Projeto Individual de Propriedade

84

Este tópico completo deve ser apresentado no PIP Ideal e no PIP pactuado 

3	 Situação atual / caracterização da propriedade

3.1	 Texto com auxílio de tabelas, mapas e fotos, de forma objetiva, das principais informações 
sobre:

•	 Uso atual da propriedade com indicativo dos cultivos e manejos realizados, rebanho e demais 

atividades produtivas;

•	 Indicação e caracterização de processos erosivos e assoreamento;

•	 Indicação e caracterização dos corpos hídricos, se intermitentes ou perenes, situação da calha 

dos cursos d’água (erosão da borda e assoreamento);

•	 Se há abastecimento doméstico, irrigação, captação de água, reservatórios, dessedentação de 

animais (direto no curso do rio ou existência de bebedouros), destinação de resíduos sólidos, 

saneamento rural e aplicação de Ato Declaratório ou Outorga.

•	 Caracterização das áreas de vegetação nativa, presença de espécies exóticas, áreas ocupadas 

por pastagem com cercamento, situação das Áreas de Proteção Permanente (APP) e Reserva 

Legal (RL) e necessidades de recomposição para adequação legal, presença de aceiros e 

histórico de incêndios.

•	 Fotos (podem estar em anexo, mas referenciadas neste texto) das principais características da 

propriedade, especialmente, das áreas degradadas, das estradas internas, pontos de erosão, 

infraestrutura de saneamento e outros pontos que tenham interesse especial.

3.2	 Mapa abrangente de localização da propriedade na bacia hidrográfica e na área do projeto, 
conforme orientações do manual.

3.3	 Mapa de uso e ocupação do solo atual, conforme orientações.

3.4	 Tabelas auxiliares para apresentação das áreas da propriedade, referente à:

•	 Uso e ocupação do solo atual da propriedade, apresentando as principais classes de uso, área 

em ha e percentual em relação a área total da propriedade, conforme exemplo:

Tabela XX - Uso e ocupação do solo atual

Classe
Área

ha %

Pastagem

Culturas temporárias

Vegetação Nativa

Estradas internas

...

Total

Fonte: Renato Atanazio.

•	 APP e RL, apresentando as áreas com vegetação existente e possíveis déficits e percentual em 

relação a área total da propriedade. Segue sugestão de exemplo:
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Tabela XX - Áreas de Preservação Permanente e Reserva Legal

Classe
Área

ha %

APP preservada

APP a recuperar

RL

Sobreposição APP x RL

Total

Fonte: Renato Atanazio.

Observações:

•	 O uso atual da propriedade servirá de linha de base para acompanhamento e monitoramento 

das ações que porventura sejam implementadas na propriedade.

•	 As fotos de pontos de interesse poderão ser inseridas diretamente neste tópico ou mantidas 

como anexo (neste caso trazer a referência das fotos no texto). 

•	 A classes de vegetação podem ser adequados de acordo com a classificação mais adequada 

para a região, como Classificação Fitogeográfica Regional, realizado pela EMBRAPA em parceria 

com outras instituições.

Estas informações devem ser apresentadas no PIP Ideal e no PIP pactuado. 

4	 Mapa Ideal

Mapa de modalidades apresentando situação de adequação hidroambiental total da propriedade, 

sendo a base da negociação com o proprietário/produtor. 

•	 Se não houver alteração entre o PIP Ideal e o PIP Pactuado, apenas indicar neste tópico que o 

proprietário aceitou 100% das recomendações do PIP Ideal.

•	 Caso haja alteração, manter este tópico com o mapa ideal e elaborar outro mapa a ser inserido 

no próximo tópico referente ao PIP Pactuado.

Este tópico deve ser apresentado no PIP Ideal e no PIP pactuado.

5	 Mapa Pactuado ou Acordado

Trata-se do mapa de modalidades ajustado de acordo com o aceite das propostas pelo proprietário/

produtor.

Este tópico deve ser apresentado no PIP pactuado

•	 Este item não aparece no PIP Ideal. 
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•	 Se não houver alteração entre o PIP Ideal e o PIP Pactuado, não há necessidade de ajuste do 

mapa ideal. Neste caso, apenas indicar no tópico anterior que o proprietário aceitou 100% das 

recomendações do PIP Ideal.

6	 Quadro de áreas

Tabela XX - Resumo das áreas e valores do PSA, por modalidade e gleba inserida no projeto

Modalidades Gleba Área (ha) Índice PSA
Valor do PSA 

(R$/Ano)
Observações

M
O

D
A

LI
D

A
D

E 
I

Conservação de solo

(Uso agropecuário)

1

2

3

Conservação de solo 

(Estradas internas)

4

5

6

Soma X,XX R$

M
O

D
A

LI
D

A
D

E 
II

Conservação de APP ou RL

7

8

9

Restauração de APP ou RL

10

11

12

Soma X,XX R$

M
O

D
A

LI
D

A
D

E 
II

I

Conservação de vegetação 

nativa excedente

13

14

15

Restauração de vegetação 

nativa excedente

16

17

18

Soma X,XX R$

Fonte: Renato Atanazio

Observações:

•	 Esta tabela resume os cálculos efetuados em planilha que contém informações mais detalhadas 

sobre o cálculo, configurada de acordo com o projeto.

•	 O manual apresenta um passo a passo para efetuar os cálculos considerando a metodologia, 

valores de referência, modalidades, itens e índices de valoração definidos como exemplo para 

o manual.

Este tópico deve ser apresentado no PIP Ideal e no PIP Pactuado

•	 Se não houver alteração entre o PIP Ideal e o PIP Pactuado, não há necessidade de ajuste.

•	 Caso haja alteração por conta da negociação, os cálculos deverão ser refeitos e esta tabela 

deverá ser atualizada aqui neste mesmo tópico. Não há necessidade de manter os dados 

apresentados no PIP Ideal.
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7	 Proposta de adequação hidroambiental 

7.1	 Resumo objetivo e direto sobre os principais problemas, propostas de adequações e 
intervenções previstas.

Pode ser apresentada uma tabela resumo das ações e intervenções para cada modalidade, como por 

exemplo:

Tabela XX - Resumo das Ações de Conservação Ambiental em cada Modalidade

Modalidade Atividade Quantidade Unidade

I - Conservação de solo

Construção de terraços metros

Construção de bacias de 

captação
unidade

Recuperação de bacias de 

captação
unidade

II – Conservação e restauração 

APP e Reserva Legal

Restauração Florestal hectares

Cercamento metros

II – Conservação e restauração 

de Remanescentes de Vegetação 

Nativa

Preservação de 

remanescente de vegetação 

nativa

hectares

Cercamento de 

Remanescentes
metros

Fonte: Renato Atanazio.

7.2	 Descrição de cada uma das glebas, classificadas por modalidades, apresentando as seguintes 
informações:

•	 Uso atual, histórico de uso do solo e caracterização do problema abordado na gleba;

•	 Descrição do projeto técnico e indicação das práticas sugeridas. Mencionar técnicas 

apresentadas nos manuais de práticas (Edáficas, Vegetativas e Mecânicas) do Programa 

Produtor de Água e apresentar referência dos métodos para necessidade de aprofundamento 

no tema.

•	 Mapas/croquis com detalhamento das glebas: inserir logo abaixo de cada descrição de gleba 

um mapa da gleba (ou agrupadas várias quando apresentarem as mesmas características). 

Estes mapas apresentam melhor os detalhes de cada gleba.

Este tópico deve ser apresentado no PIP Pactuado

8	 Cronograma de atividades e desembolsos

8.1	 Tabela de cronograma das atividades previstas para a propriedade.

Pode ser dividida por ano de contrato e por trimestre de realização das intervenções, conforme 

exemplo. Deve conter minimamente informações sobre: assinatura do contrato, atividades de manutenção 

e intervenções por modalidades, vistorias de monitoramento e desembolsos (conversando com o 

cronograma de desembolso).

A depender da necessidade, as informações nas linhas poderão ser apresentadas também por prática 

ou intervenção prevista.
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Tabela XX - Cronograma das atividades previstas para a propriedade

Ano 1 Ano 2 Ano 3 Ano 4 Ano 5

Atividades/

Trimestres

Assinatura do 

contrato

Atividades 

modalidade I

Atividades 

modalidade II

Atividades 

modalidade III

Vistorias 

monitoramento

Atividades de 

manutenção

Desembolsos

Fonte: Renato Atanazio.

8.2	 Cronograma de desembolso do PSA

Tabela XX - Cronograma de desembolso do PSA

Modalidades

1º Desembolso 2º Desembolso 3º Desembolso 4º Desembolso 5º Desembolso

Assinatura do 
contrato

1 ano 2 anos 3 anos 4 anos

UFM R$ UFM R$ UFM R$ UFM R$ UFM R$

Modalidade I

Modalidade II

Modalidade III

TOTAL

Fonte: Renato Atanazio.

Observações:

Quando definido o Valor de Referência, sugere-se indexar a algum tipo de índice ou valor (como aqui 

apresentado em UFM) para atualização monetária dos valores apresentados no momento dos pagamentos

Este tópico deve ser apresentado no PIP pactuado 

9	 Planilha de custos das intervenções 

A depender da necessidade, alguns projetos podem optar por inserir uma planilha orçamentária 

referente aos valores de custo das intervenções a serem realizadas na propriedade. O objetivo é apresentar 

ao proprietário/produtor o custo do investimento feito na propriedade para que ele entenda que há muito 
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além do valor do PSA recebido. Porém, este item pode deixar o PIP muito complexo, considerando que 

estes valores podem mudar frequentemente, exigindo constante atualização.

Caso seja incluída no PIP, verificar formato e conteúdo nos demais manuais de práticas do Programa 

Produtor de Água.

Este tópico pode ser apresentado no PIP pactuado 

10	 Observações gerais e recomendações

10.1	 Texto com auxílio de tabelas, de forma sintética e objetiva, das principais informações sobre o 
PIP:

•	 Resumo da caracterização do uso atual da propriedade;

•	 Problemas e necessidades de adequação;

•	 Breve relato sobre as técnicas conservacionistas escolhidas e as metodologias para sua 

implementação. Informar número de glebas por modalidade;

•	 Mencionar as propostas do PIP Ideal e quais foram aceitas pelo proprietário e validadas pela 

UGP;

•	 Recomendações para monitoramentos e vistorias; e,

•	 Recomendações gerais.

Este tópico deve ser apresentado no PIP pactuado

11	 Proposta de concordância

A “Proposta de concordância do produtor rural com o Projeto Individual da Propriedade-PIP” deverá 

ser preenchida pelo Responsável Técnico pela elaboração do PIP com uma descrição sumária das ações 

propostas, quantificando-as corretamente, assim como suas respectivas áreas em hectares. Após o 

preenchimento desse campo, o restante do formulário deverá ser preenchido e assinado pelo produtor, o 

qual deverá ser assinada e posteriormente entregue a instituição responsável pelo contrato, juntamente.

Tabela xx - Proposta de concordância do Produtor Rural

MODALIDADE I – Conservação de Solos

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)

MODALIDADE II – Conservação e Restauração de APP e RL

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)
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MODALIDADE III – Conservação de Vegetação Nativa Excedente

Gleba
PIP Ideal Aceite Produtor

Ação Área (ha) Ação Área (ha)

Fonte: Renato Atanazio.

Observações:

Incluir espaço para nome e assinatura do Proprietário e pelo responsável técnico com número de 

registro e nome do órgão de representação de classe, identificação da equipe de apoio, a data da visita na 

propriedade.

Este tópico deve ser apresentado no PIP Ideal (para preenchimento) e no PIP Pactuado (preenchido 

e assinado para registro)

12	 Anexos do PIP

•	 Registro fotográfico da propriedade com as devidas referências das glebas e/ou dos usos 

atuais e práticas.

•	 Formulário de requerimento de cadastro assinado.

•	 Mapas complementares.
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ANEXO B – MODELO DE TERMO DE REFERÊNCIA PARA 
CONTRATAÇÃO DE SERVIÇOS DE ELABORAÇÃO DE PIPS

Termo de Referência

1. OBJETO

1.1. Contratação de empresa para serviço de elaboração dos Projetos Individuais de Propriedades (PIP) e 

assessoria técnica para apoio, suporte técnico e acompanhamento da execução do Projeto Produtor de 

Água NOME DO PROJETO, no município de NOME MUNICÍPIO E ESTADO.

2. JUSTIFICATIVA 

2.1. A contratação desse serviço é necessária às ações do projeto, criado pela Lei XXXXXX e regulamentado 

pelo Decreto XXXXX, promovendo sua ampliação para atender o maior número possível de propriedades. 

2.2. Conforme planejamento estratégico realizado pela UGP (Unidade de Gestão do Projeto), foi identificada 

a necessidade de contratação de empresa para prestação de serviços de apoio à execução do projeto, tendo 

em vista a dimensão reduzida da estrutura técnica e administrativa da INSTITUIÇÃO RESPONSÁVEL para 

que ocorra expansão do projeto na área de abrangência prevista.

3. ESPECIFICAÇÃO DO OBJETO

3.1. Conceituação do Projeto Individual de Propriedade (PIP):

3.1.1. O projeto Produtor de Água NOME DO PROJETO tem como principal objetivo incentivar proprietários 

e produtores rurais a adotarem voluntariamente práticas de manejo conservacionista em suas propriedades, 

as quais se tornam as unidades territoriais centrais para o planejamento e a gestão das intervenções. 

3.1.2. No contexto do programa e dos projetos Produtor de Água, o Projeto Individual de Propriedade (PIP) é 

um documento técnico de planejamento e execução que direciona as ações de adequação e implementação 

das práticas na propriedade.

3.1.3. No PIP, cada propriedade rural é objeto de um estudo diagnóstico individualizado com utilização de 

ferramentas de geoprocessamento para cálculo e delimitação das áreas, caracterização do uso do solo, 

além da identificação das características naturais e das exigências de proteção e recuperação previstas em 

mecanismos legais de adequação ambiental.

3.1.4. O PIP é o instrumento de planejamento da propriedade rural para conservação do solo e dos recursos 

hídricos, que documenta as boas práticas adotadas pelo produtor rural e sua respectiva valoração financeira, 

explicitando o vínculo existente entre o manejo da propriedade e a respectiva remuneração.

3.2. A elaboração do PIP envolve, basicamente, realizar o diagnóstico da propriedade para propor uma nova 

distribuição de uso do solo, alinhada aos objetivos do projeto, por meio de um plano de ação que otimize 

os recursos disponíveis. O processo do PIP é dividido em duas etapas: o PIP Ideal e o PIP Pactuado.

3.2.1. O PIP Ideal busca a máxima adequação hidroambiental da propriedade, conforme as diretrizes do 

projeto e a legislação vigente. Ele é apresentado ao proprietário ou produtor para negociação, podendo ser 

aceito total ou parcialmente. Este documento deve ser objetivo, com informações concisas, focando nas 

propostas de uso futuro da propriedade.

3.2.2. O PIP Pactuado é elaborado após a negociação, refletindo o acordo entre as partes sobre as 

intervenções a serem implementadas. Ele é a base para o cálculo dos valores de PSA, elaboração de contratos, 
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implementação de práticas conservacionistas e monitoramento dos serviços ambientais prestados. O PIP 

Pactuado complementa o PIP Ideal, com informações detalhadas de um projeto técnico para execução das 

ações previstas.

3.2.3. Embora o PIP Ideal e o PIP Pactuado sejam etapas distintas, eles fazem parte de um único processo. 

O PIP Ideal apresenta as propostas de possibilidades de adequação, e, após a negociação, é ajustado para 

se tornar o PIP Pactuado.

3.3. A área de abrangência do edital/TdR está localizada no município de XXXXXX-UF, possui XXX hectares 

e, INFORMAR SOBRE LEVANTAMENTOS PRÉVIOS SOBRE A EXPECTATIVA DE NÚMERO DE PROPRIEDADES 

COM POSSIBILIDADE DE PARTICIPAÇÃO (como consultas do CAR, resultados de diagnósticos, entre outros.) 

3.4. As propriedades que podem participar do NOME DO PROJETO são aquelas que possuem ao menos 

XX% de sua área dentro da área de abrangência indicada no Edital de Chamamento nº XXXXXX (Figura X). 

Mais informações sobre edital e o projeto podem ser obtidas no site: https://www.

4. ATIVIDADES PREVISTAS

4.1. Atividade 1 - Mobilização de proprietários rurais, que consiste nas seguintes atividades: 

4.1.1. Uma das atividades de mobilização consiste em organizar e realizar X eventos anuais para até XX 

pessoas na área XXXXXX para divulgação do projeto. Caberá à contratada organização, locação do local se 

necessário, providenciar coffee break, elaborar a programação em conjunto com a UGP e entrar em contato 

com proprietários rurais para convidá-los a participar do evento. Os eventos deverão ser registrados por 

fotos e lista de presença, que deverão ser entregues à INSTITUIÇÃO RESPONSÁVEL.

4.1.2. A contratada deverá fazer contato com potenciais participantes e fazer visitas à área de abrangência 

do NOME DO PROJETO e às propriedades interessadas para engajar novas adesões.

4.1.3. Nas visitas, deverá ser explicado como funciona o projeto, as condições para participação, resultados 

esperados de acordo com os objetivos do projeto, bem como sanar as dúvidas dos proprietários rurais para 

tentar engajar novos participantes. 

4.1.4. A partir das visitas, a contratada deverá elaborar um banco de dados de propriedades, com 

identificação do proprietário, data da visita, número da visita àquela propriedade, telefone de contato, 

localidade, coordenadas geográficas da sede ou acesso principal, interesse do proprietário em participar 

do projeto, situação do documento de posse (principal questão abordada na visita) e outras informações 

que forem pertinentes. Este documento deverá ser atualizado constantemente e entregue mensalmente à 

INSTITUIÇÃO RESPONSÁVEL ou quando solicitado. 

4.1.5. A contratada deverá auxiliar os proprietários rurais a reunirem a documentação necessária para 

inscrição no projeto, que está listada no Edital de Chamamento nº XXXXX, vigente até o dia XX/XX/XXXX e/ou 

no documento de referência do projeto que apresenta as regras e critérios de execução.

4.1.6. A contratada terá o apoio da UGP para indicar potenciais proprietários e instituições parceiras para 

realização dos eventos.

4.2. Atividade 2 - Elaboração dos Projetos Individuais de Propriedades (PIPs).

Os procedimentos para elaboração dos PIPs deverão ser seguidos a partir do Manual de Orientações 

para Elaboração de PIP disponibilizado pelo Programa Produtor de Água neste link [hiperlink do manual] 

considerando os critérios e regras referentes às especificidades locais do NOME DO PROJETO que constam 

em um documento de referência a ser disponibilizado pela INSTITUIÇÃO RESPONSÁVEL. As regras tratam 

basicamente das seguintes questões:

https://www


93

Série Manuais do Programa Produtor de Água: Vol.3 Elaboração de Projeto Individual de Propriedade

4.2.1. Objetivos e prioridades do projeto: objetivos geral e específicos do projeto, a justificativa para 

implantação do projeto e quais são as ações prioritárias para atacar o problema identificado nas fases iniciais 

do projeto, bem como nos resultados de estudos como o diagnóstico socioambiental da bacia.

4.2.2. Critérios de elegibilidade e condições para participação: São as exigências mínimas para participação 

do projeto, especificando as condições que os proprietários ou produtores responsáveis pelas terras devem 

atender para se qualificarem aos benefícios do projeto. Considera-se aqui a documentação necessária que 

habilitam o proprietário/possuidor da área, bem como outros critérios técnicos que devem estar alinhados 

aos objetivos do projeto;

4.2.3. Critérios de priorização para contratação das propriedades: São critérios que avaliam a propriedade 

dentro dos objetivos e prioridades estabelecidos para o projeto, definindo quais propriedades terão 

prioridade na contratação. Essa classificação e o estabelecimento de um ranking dentro do universo de 

propriedades cadastradas (que cumpriram os critérios de elegibilidade) permitem saber por onde começar 

as contratações, além de estabelecer critérios de desempate no caso de a procura pelo projeto ser maior 

do que o recurso disponível. 

4.2.4. Aspectos legais e regulatórios: conjunto de legislações ambientais, fundiárias e administrativas para 

garantir que as práticas de conservação e recuperação nas propriedades rurais estejam em conformidade 

com a legislação vigente. Essas normas não apenas oferecem respaldo jurídico, como também asseguram 

a viabilidade legal e a sustentabilidade ambiental do projeto, garantindo que os proprietários rurais e as 

instituições envolvidas atuem dentro dos limites legais e obtenham os benefícios esperados. 

4.2.5. Metodologia de cálculo dos valores de PSA: modalidades, valores de referência (VRE), tabela de cálculo 

com os critérios e índices de valoração para cada modalidade e procedimento para realização dos cálculos 

dos valores de PSA.

4.2.6. A contratada deverá utilizar como base de apoio o Cadastro Ambiental Rural (CAR) para identificação 

de áreas que poderiam ser inseridas no Produtor de Água como conservação, restauração e identificação 

de possíveis conflitos de área. 

4.3. A elaboração do PIP será feita em contato com o proprietário, visitas in loco, utilização de banco de 

imagens e base de dados oficiais. 

4.3.1. Os dados geográficos de hidrografia, área do projeto e malha viária e as imagens de satélite e de uso 

do solo deverão ser obtidas a partir de dados oficiais disponíveis em escala compatível para a realização 

dos trabalhos ou serão disponibilizadas pela contratante para confecção dos mapas. A contratada não está 

autorizada a utilizar este material em outros serviços e nem realizar seu compartilhamento. Caso deseje 

utilizá-los, deverá solicitar autorização à INSTITUIÇÃO RESPONSÁVEL como qualquer outra instituição. 

4.3.2. Se forem identificados nascentes ou cursos d’água na propriedade e que não estejam nos dados de 

hidrografia disponibilizados, estes devem ser mapeados e o registro cartográfico enviado junto com o PIP 

em formato Shapefile ou GeoPackage. 

4.3.3. Os mapas deverão ser elaborados conforme orientações do Manual de Orientações de Elaboração de 

PIPs do Programa Produtor de Água. 

4.3.4. Se quando a contratada for realizar o mapeamento dos limites e identificação das divisas, verificar que 

não é possível concluir o trabalho devido à ausência de dados ou conflitos de divisas com propriedades 

vizinhas, o PIP não será concluído e será o pago à contratada apenas 10% do valor total daquele PIP pelo 

serviço prestado. Esta impossibilidade de conclusão deverá ser atestada pela INSTITUIÇÃO RESPONSÁVEL. 

4.3.5. O acesso às áreas e insumos necessários são de responsabilidade da contratada. Pode ser necessário 

o uso de veículos com tração e vestimentas adequadas para acessar determinadas áreas.
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4.4. Atividade 3 - Realização de vistorias.

4.4.1. A atividade de vistoria compreende a visita in loco às propriedades rurais que participam do Projeto 

Produtor de Água NOME DO PROJETO com o uso de INDICAR EQUIPAMENTOS NECESSÁRIOS. 

4.4.2. A INSTITUIÇÃO RESPONSÁVEL não disponibilizará INDICAR EQUIPAMENTOS NECESSÁRIOS para 

contratada. Este equipamento é de responsabilidade da contratada. 

4.4.3. Será enviado à contratada os mapas das propriedades participantes para que seja possível a sua 

identificação em campo.

4.4.4. A contratada deverá fazer registros fotográficos das áreas do Projeto Individual de Propriedade (PIP) e 

verificar se houve algum sinal de interferência ou degradação. 

4.4.5. A partir das imagens e visitas, a contratada deverá elaborar relatório com seu parecer e elaborar 

relatório de vistoria nos moldes solicitados pela INSTITUIÇÃO RESPONSÁVEL. A contratada poderá sugerir 

melhorias e adequações ao modelo de relatório caso assim entenda.

4.4.6. O relatório de vistoria deve ser entregue pela contratada em até XX dias após a realização da visita de 

campo. 

4.5. Condições gerais de execução do serviço.

4.5.1. Todos os equipamentos e insumos necessários para a execução das atividades deverão ser fornecidos 

pela contratada, inclusive o deslocamento até as áreas contempladas. Algumas das áreas são de difícil 

acesso, exigindo veículo traçado para chegar ao local. 

4.5.2. Os funcionários da empresa e veículos da contratada que farão as visitas de campo deverão estar 

uniformizados e identificados com crachá e logo escritos “a serviço da INSTITUIÇÃO RESPONSÁVEL”, 

ficando sob responsabilidade da contratada as despesas necessárias para atendimento inclusive deste item. 

4.5.3. Após solicitação pela contratante para realização do serviço, a contratada deverá iniciar o atendimento 

da demanda no prazo máximo de X dias úteis.

4.5.4. A segurança, guarda e conservação de todos os materiais, equipamentos, ferramentas e utensílios e 

ainda pela proteção destes e das instalações dos serviços, durante seu período de execução, também são 

de responsabilidade da contratada. 

4.5.5. Na execução dos trabalhos, deverá haver plena proteção contra o risco de acidentes com o pessoal 

da contratada e com terceiros. Para isso a contratada deverá cumprir fielmente o estabelecido na legislação 

nacional, no que concerne à segurança, bem como obedecer a todas as normas apropriadas e específicas 

para a segurança de cada tipo de serviço. 

4.5.6. A contratada deverá realizar o esforço de manter os mesmos profissionais indicados para execução 

do serviço ao longo da vigência do contrato, visto que o serviço envolve contato com proprietários rurais 

e é necessário estabelecer um vínculo de confiança para sua realização. A troca de profissionais poderá 

prejudicar o andamento e a conclusão dos serviços.

5. PRODUTOS A SEREM ENTREGUES 

5.1. Deverá ser entregue mensalmente relatório de execução do serviço, contendo:

5.1.1. Registro de eventos de mobilização, apenas nos meses em que ocorrerem, com registro fotográfico, 

lista de presença e descrição detalhada; 

5.1.2. Banco de propriedades atualizado. 

5.1.3. Os Projetos Individuais de Propriedades (PIP’s) elaborados no período.
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5.1.4. Os relatórios das vistorias realizadas no período.

5.1.5. Relatório dos serviços de assessoramento a UGP e secretariado realizados no período, inclusive com 

o registro das horas dedicadas à sua execução; 

5.1.6. Os produtos deverão ser apresentados em língua portuguesa, lida e falada no Brasil, e entregues em 

meio digital. Os textos e planilhas dos relatórios deverão ser entregues nos formatos PDF e em arquivos em 

formatos editáveis, em Word e Excel. Os mapas e arquivos com georreferenciamento deverão ser entregues 

em PDF, kml e Shapefile ou GeoPackage. 

5.2. Além dos relatórios ao final de cada período anterior ao pagamento, caberá à contratada o fornecimento 

e manutenção de um DIÁRIO DE CAMPO MENSAL. Deverá ser enviado em formato digital para o fiscal do 

contrato em até XX dias após o final de cada mês. O diário também deverá conter informações sobre o 

serviço executado no mês finalizado, indicando exatamente o que foi realizado e em qual localidade. 

5.2.1. A sua manutenção, aquisição e guarda são de inteira responsabilidade da contratada. Os diários de 

campo deverão ser anexados ao relatório enviado referente ao período anterior ao pagamento. 

5.2.2. As observações, dúvidas e questionamentos técnicos que porventura surgirem sobre a realização dos 

trabalhos da contratada, deverão ser anotados e assinados pela INSTITUIÇÃO RESPONSÁVEL, e, aquela se 

obriga a dar ciência dessas anotações respondendo ao email enviado pela contratada.

5.2.3. Além das anotações obrigatórias sobre os serviços em andamento e os programados, a contratada 

deverá recorrer ao Diário de Campo, sempre que surgirem quaisquer improvisações, alterações técnicas ou 

serviços imprevistos decorrentes de acidentes, ou condições especiais. 

5.2.4. Serão obrigatoriamente registrados no Diário de Campo, pela contratada: 

5.2.4.1. O serviço executado ao longo do dia; 

5.2.4.2. Os equipamentos e materiais utilizados; 

5.2.4.3. As condições meteorológicas prejudiciais ao andamento dos trabalhos; 

5.2.4.4. As falhas nos serviços de terceiros, não sujeitas à sua ingerência; 

5.2.4.5. As consultas à fiscalização;

5.2.4.6. As datas de conclusão de etapas caracterizadas de acordo com o cronograma aprovado; 

5.2.4.7. Os acidentes ocorridos no decurso dos trabalhos; 

5.2.4.8. As respostas às interpelações da INSTITUIÇÃO RESPONSÁVEL; 

5.2.4.9. A eventual escassez de material que resulte em dificuldades para os trabalhos; 

5.2.4.10. Outros fatos que, ao juízo da contratada, devem ser objeto de registro. 

6. QUALIFICAÇÃO TÉCNICA 

6.1. A empresa contratada deverá apresentar Prova de Registro e Regularidade junto ao Conselho Regional 

de Engenharia e Agronomia (CREA) ou junto ao Conselho Regional de Biologia (CRBIO).

6.2. Deverá ser apresentado minimamente um profissional de engenharia ambiental, florestal, agronômica 

ou biologia, habilitado pelo seu respectivo conselho de classe a emitir Anotação de Responsabilidade 

Técnica (ART) pelos serviços executados através desta contratação, com experiência em: 

6.2.1. Sistema de Informação Geográfica (SIG) e Geoprocessamento;

6.2.2. Conservação e restauração de vegetação nativa;
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6.2.3. Extensão rural para assistência técnica personalizada;

6.2.4. Engenharia para cálculos e definição de estratégias para retenção do escoamento da água de chuva 

e de sedimentos.

6.2.5. A comprovação deste item será mediante apresentação de comprovante de registro no respectivo 

conselho, acervo pessoal ou currículo que indique a experiência nos itens 4.2.1, 4.2.2, 4.2.3 e 4.2.4 por meio 

de serviço realizado anteriormente. Também poderá ser apresentado certificado de curso para comprovação 

de experiência nestes itens. 

6.3. O relacionamento com os agricultores é fundamental, pois o processo de elaboração do PIP é feito de 

forma colaborativa e negociada. Isso exige uma série de competências interpessoais e habilidades humanas, 

as quais geralmente são comuns aos profissionais de extensão rural, tais como:

6.3.1. Comunicação eficaz - o profissional deve ser capaz de comunicar conceitos técnicos de forma clara, 

adaptando a linguagem ao nível de conhecimento do produtor e ao contexto cultural da comunidade rural.

6.3.2. Conhecimento e respeito à cultura e tradições locais - um profundo entendimento da cultura local 

é crucial para estabelecer confiança e promover a adoção de novas práticas. Recomendações técnicas 

devem ser sensíveis às tradições e práticas econômicas locais, para que os produtores se sintam respeitados 

e compreendidos.

6.3.3. Mediação e resolução de conflitos que podem surgir tanto entre os próprios produtores quanto entre 

produtores e outros atores envolvidos no projeto (órgãos ambientais, governo etc.). O profissional precisa 

mediar esses conflitos de maneira pacífica e imparcial.

6.3.4. Habilidade de negociação - o técnico deve ser capaz de negociar com o produtor, identificando suas 

necessidades específicas e propondo soluções práticas que sejam viáveis para ele, dentro dos objetivos do 

projeto. A negociação deve sempre buscar um equilíbrio entre as necessidades do produtor e os resultados 

esperados do projeto.

6.3.5. Liderança e tomada de decisão: Em muitos casos, os técnicos assumem uma posição de liderança no 

projeto, sendo responsáveis por tomar decisões estratégicas que orientem o produtor em direção a uma 

maior sustentabilidade e produtividade.

6.4. Para atendimento dos itens 6.2 e 6.3, poderá ser apresentado mais de um profissional, desde que as 

experiências em conjunto dos profissionais apresentados atendam o solicitado. 

6.5. A empresa deverá apresentar atestado de capacidade técnica ou declaração emitido por pessoa jurídica 

de direito público ou privado, comprovando que já realizou serviço de mapeamento de áreas rurais. O 

atestado deverá conter no mínimo as informações que permitam o entendimento do serviço executado, tais 

como: período e local de execução, área executada, descrição do serviço e técnicas utilizadas. O atestado 

poderá conter outras informações que a empresa julgar pertinentes para melhor compreensão do serviço 

executado.

7. LOCAL E FORMA DA ENTREGA/PRESTAÇÃO DO SERVIÇO 

7.1. O serviço será realizado na Bacia NOME DA BACIA, na área de abrangência do Projeto NOME O 

PROJETO. Os relatórios deverão ser entregues em formato digital na sede administrativa da INSTITUIÇÃO 

RESPONSÁVEL – ENDEREÇO DA INSTITUIÇÃO RESPONSÁVEL – entre INDICAR HORÁRIOS.

8. VALOR GLOBAL ESTIMADO RESTRITO 

INFORMAR VALOR
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9. QUANTITATIVO E PLANILHA DE COMPOSIÇÃO 

9.1. Segue na Tabela 1 a composição de preço que foi estabelecida com base em pesquisa no Portal 

Nacional de Contratações Públicas (PNCP), atas de registro de preço, tabela SINAPI e consulta direta com 

fornecedores.

Tabela 1 – Planilha com quantitativo.

Item Serviço Unidade Qde Valor un. (R$) Valor total (R$)

1
Mobilização de 

proprietários rurais

Propriedade 

visitada

Evento realizado

3 Elaboração de PIP Hectares

4
Realização de 

vistorias
Vistorias realizadas

TOTAL

10. FORMA DE PAGAMENTO 

10.1. Os produtos finais e a medição deverão ser protocolados no INDICAR SE HÁ SISTEMA DE PROTOCOLO. 

10.2. Os pagamentos serão realizados em até XX dias após o protocolo da nota fiscal com toda documentação 

completa exigida, com aprovação da INSTITUIÇÃO RESPONSÁVEL, conforme o cronograma Físico 

Financeiro, descrito na Tabela 2. 

10.3. Pagamento do serviço “1. Mobilização de proprietários rurais”. 

10.3.1. Será pago conforme a demanda e por propriedade visitada. Será necessário visitar mais de uma vez 

a mesma propriedade. Em cada visita, já está previsto o retorno à propriedade. Ou seja, uma visita e um 

retorno correspondem ao valor unitário estimado na planilha de composição de preço. 

10.3.2. Será pago conforme a demanda por evento realizado. 

10.4. Pagamento do serviço “2. Elaboração de Projeto Individual de Propriedade (PIP)”. 

10.4.1. Será pago conforme a demanda após a conclusão do PIP, valor referente à quantidade de hectares 

totais da propriedade. 

10.4.2. Se quando a contratada for realizar o mapeamento dos limites e identificação das divisas, verificar 

que não é possível concluir o trabalho devido à ausência de dados ou conflitos de divisas com propriedades 

vizinhas, o PIP não será concluído e será o pago à contratada apenas 10% do valor total daquele PIP pelo 

serviço prestado. Esta impossibilidade de conclusão deverá ser atestada pela fiscalização. 

10.5. Pagamento do serviço “3. Realização de vistorias”.  Será pago conforme a demanda por vistoria realizada. 

11. PRAZO CONTRATUAL E CRONOGRAMA DE PAGAMENTO 

11.1. O prazo para execução do serviço é de XX meses, conforme cronograma abaixo, contados a partir da 

emissão da Autorização de Fornecimento.
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Tabela 2 – Cronograma físico

Mês 
1

Mês 
2

Mês 
3

Mês 
4

Mês 
5

Mês 
6

Mês 
7

Mês 
8

Mês 
9

Mês 
10

Mês 
11

Mês 
12

Mobilização

Eventos

Elaboração dos 

PIPs

Vistorias

12. DA VISITA TÉCNICA 

12.1. Os licitantes interessados podem realizar visita técnica na área de abrangência do Projeto NOME DO 

PROJETO de modo a certificar-se das condições locais e necessidades específicas para a prestação do 

serviço, não podendo posteriormente alegar desconhecimento de tais fatores. Visitas técnicas deverão ser 

agendadas pelo telefone XXXXXX, de INDICAR DIAS, entre INDICAR HORÁRIO.
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